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This is the safety alert symbol. It is used to alert you to potential personal
IMPORTANT injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

° DANGER—Indicates a hazardous situation which, if not avoided, will result in death

or serious injury.

WARNING—Indicates a hazardous situation which, if not avoided, could result in

death or serious injury.

o CAUTION—Indicates a hazardous situation which, if not avoided, could result in
minor or moderate injury.

. NOTICE—Indicates a hazard that could result in property damage only (including
damage to the control).

. IMPORTANT—Designates an operating tip or maintenance suggestion.

DEFINITIONS

The engine, turbine, or other type of prime mover should be equipped with an
overspeed shutdown device to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover
control system. An overtemperature or overpressure shutdown device may also
be needed for safety, as appropriate.

installing, operating, or servicing this equipment. Practice all plant and safety instructions and

f Read this entire manual and all other publications pertaining to the work to be performed before
precautions. Failure to follow instructions can cause personal injury and/or property damage.

you have the latest revision, be sure to check the Woodward website:
www.woodward.com/pubs/current.pdf
The revision level is shown at the bottom of the front cover after the publication number. The latest
version of most publications is available at:
www.woodward.com/publications
If your publication is not there, please contact your customer service representative to get the
latest copy.

f This publication may have been revised or updated since this copy was produced. To verify that

electrical, or other operating limits may cause personal injury and/or property damage, including
damage to the equipment. Any such unauthorized modifications: (i) constitute "misuse" and/or
"negligence” within the meaning of the product warranty thereby excluding warranty coverage
for any resulting damage, and (ii) invalidate product certifications or listings.

To prevent damage to a control system that uses an alternator or battery-charging
N O TI CE device, make sure the charging device is turned off before disconnecting the battery

f Any unauthorized modifications to or use of this equipment outside its specified mechanical,

from the system.

To prevent damage to electronic components caused by improper handling, read
NO TICE and observe the precautions in Woodward manual 82715, Guide for Handling and

Protection of Electronic Controls, Printed Circuit Boards, and Modules.

l Revisions—Text changes are indicated by a black line alongside the text.

Woodward Governor Company reserves the right to update any portion of this publication at any time. Information
provided by Woodward Governor Company is believed to be correct and reliable. However, no responsibility is assumed
by Woodward Governor Company unless otherwise expressly undertaken.
© Woodward 2001
All Rights Reserved
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Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others.
To protect these components from static damage, you must take special
precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static
electricity on your body to ground by touching and holding a grounded metal
object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing
made of synthetic materials. Wear cotton or cotton-blend materials as much
as possible because these do not store static electric charges as much as
synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam
cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or
folders, plastic bottles, and plastic ash trays) away from the control, the
modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the control cabinet
unless absolutely necessary. If you must remove the PCB from the control
cabinet, follow these precautions:

e Do not touch any part of the PCB except the edges.

° Do not touch the electrical conductors, the connectors, or the
components with conductive devices or with your hands.

e  When replacing a PCB, keep the new PCB in the plastic antistatic
protective bag it comes in until you are ready to install it. Immediately
after removing the old PCB from the control cabinet, place it in the
antistatic protective bag.

To prevent damage to electronic components caused by improper

NO TICE handling, read and observe the precautions in Woodward manual
82715, Guide for Handling and Protection of Electronic Controls,
Printed Circuit Boards, and Modules.

iv Woodward
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Chapter 1.

General Information
]

Introduction

This manual describes how to install, monitor and commission your EGS-01
(Engine Gas-metering System). The manual is applicable for both types of EGS:
e EGS with speed and load control

e EGS without speed and load control

The parts of the manual applicable for EGS with speed and load control are
clearly indicated.

Application

The EGS-01 is a gas-engine control module that can be used to control the gas
flow in relation to airflow, at any engine load and speed condition. It can be
applied to in-line and V-engines of any power output, naturally aspirated or turbo-
charged.

The control is easily programmable by PC and it covers the wide range of gas
qualities from landfill gas through to propane. Even a significant change in gas
quality during normal operation of the engine is compensated by the control.

Explanation of names often used in a gas quality closed loop application

Mono system One gas flow calculation per engine

Stereo system Two gas flow calculations; one for each separate bank of a V-engine

Single TecJet system |One TecJet per gas flow calculation

Dual TecJet system Two TecJets per gas flow calculation

A system that uses two different gas types, e.g. biogas and natural gas,

Dual Fuel system .
simultaneously.

Gas Flow Actuator

The EGS-01 forms an ideal combination with the TecJet™ (as developed by
Woodward). The TecJet is an intelligent gas-metering actuator that converts the
mass flow of gas, calculated by the EGS-01 control, into an actual gas flow to the
engine.

From the EGS-01 the TecJet receives a gas-flow demand signal and the density
of the gas, and the TecJet transmits data, such as gas temperature and
pressure, differential pressure over the valve and the valve position, to the
EGS-01.

Gas Quality Closed Loop

To keep the NOx emissions low, the engine should run at the correct Air to Fuel
Ratio, over the entire speed and load range of the engine. In this manual the Air
to Fuel Ratio is expressed by the symbol A (=1/¢). For maintaining A over a
longer period of time, even with a changing gas composition, Woodward does
not rely on the feedback signal of an oxygen sensor that can be located in the
exhaust pipe of the gas engine.

Woodward 1
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A patented control algorithm (Eur. Patent no. 0727574) in the EGS-01 control
compensates automatically for a changing gas composition.

Using the programmed lower heat value of the gas, the calculated gas flow
through the TecJet and the programmed efficiency of the generator set, the
control calculates the power of the set. The ratio between the calculated power
and the measured power is used for correction of the actual gas flow to the
engine.

Generator Power Output

The Gas Quality Closed Loop option has been designed to be applied on
generator sets, where a kW-signal is normally available. However a torque-signal
also can be applied. A torque sensor is required when a gas-engine driven
compressor is controlled by the system in Gas Quality Closed Loop mode.

Trim System versus Full Authority Systems

The number of gas engines that are equipped with Deltec Fuel Systems
carburetors is about 50 000. These engines are operated with a simple and
reliable fixed venturi type carburetor, an adjustable lean/rich gas valve and a
zero-pressure regulator. The engine can be controlled with these three
components. A A-control can be used for small corrections of the gas flow,
however the basic air/fuel ratio is determined by Bernoulli’s Law and the engine
even can run with a disconnected A-control. Such a A-control only has a trim
function.

The EGS-01 is a full-authority system. This means that the total gas flow is
calculated by the control, based on parameters such as load, speed and gas
data. The engine cannot be operated without this control.

The biggest advantage of a full-authority system is the flexibility and the
improved engine performance like starting, stability, transient and emissions.
Control software, sensors and the control module will always be the same, only
the size of the actuator is related to the engine output.

Gas Flow Calculation

To calculate the required fuel flow to an engine the airflow must be measured.
Two methods are generally used. For smaller engines air mass-flow sensors
based on hot wire or thin-film technology are used, mainly in the automotive
industry.

In the EGS-01 control the so-called Speed/Density principle has been used. This
principle calculates the mixture flow to the engine based on engine speed,
cylinder displacement, manifold pressure and temperature, and volumetric
efficiency of the engine.

This method is usually applied on larger bore engines for reliability and flexibility
reasons.

2 Woodward
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Accessories
MAP sensor To measure Manifold Air Pressure (MAP)
MAT sensor To measure Manifold Air Temperature (MAT)
MPU Magnetic Pick Up (MPU) to measure engine speed

Universal Exhaust Gas |To measure the A/F Ratio of the gas engine (only during
Oxygen (UEGO) sensor |commissioning)

For load sharing, droop-parallel or power closed loop mode
at generator applications

Generator Load Sensor

Contents Included in this Package

Make sure that you have the items as listed below in the package:

e EGS-01 control

e  EGS monitoring software diskette

e EGS manual (36139, this manual) (check our website for the latest issue,
www.woodward.com)

After unpacking, check the EGS-01 control for signs of damage such as bent or
dented panels, scratches, and broken parts. Contact Woodward if the control is
damaged.

Woodward 3
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Chapter 2.

Installation
]

Introduction

This chapter describes how to install your EGS-01 control and sensors.
Installation procedures also cover power requirements and location
considerations.

Location Considerations for the EGS-01 Control

Consider the following requirements when you select a mounting location for

your EGS-01 control:

e  When the EGS-01 control is located inside the engine room, then the unit
should be mounted inside a separate cabinet to protect the unit from dirt,
dust and heat radiation of the exhaust pipe.

o  When the unit is located outside the engine room, then the cabinet of the
generator set generally is used if there is sufficient space in this cabinet.

e  The unit can be mounted in both a horizontal or/or a vertical orientation.

e Do not mount the EGS control on the engine or engine frame.

For user-friendly installation and operation of the unit, it is
IMPORTANT recommended that the unit is installed not lower than one meter and

not higher than two meters from the floor.

8182

e Please take into account that the cover of the control, or the entire control,
must be removable for servicing.

e  Prevent the unit control from direct exposure to water or condensation
situations that exceed the limits set by IP56.

e  Operating temperature between —20 and +105 °C.

¢ Install the EGS-01 control on a metal ground plate to ground the whole
system.

For dimensions see the outline drawing, Figure 2-2.

41 50/|51 60

I (T T LTI
T T T T T

71

Figure 2-1. Terminal Numbers on the EGS-01

Handling

The EGS-01 has Phoenix connectors on the Printed Circuit Board (PCB). The
counter part with the wire terminals is Woodward part number DL26600106. The
upper deck connectors (terminal 41-80) must be removed to connect wires to the
lower deck terminals (terminal 1-40).

4 Woodward
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With this type of connector it is possible to replace the control without
disconnecting the bulk of the wiring from the wire terminals. Only the two power
supply wires need to be disconnected from terminals 81 and 82 (using a small

screwdriver).

Use a small screwdriver to separate the wire terminal part of the

IMPORTANT connector from the PCB part. Place the screwdriver between the two
parts and turn the screwdriver, first on one side of the connector,
then on the other. Do not force the connector apart.

Connect all shielded wires to the stud on the EGS-01 control; see Figure 2-2.

Install the EGS-01 Control

Shielded Wiring

Install the EGS-01 control with four screws as shown in Figure 2-2.

For installation of the TecJet gas control valve, see Woodward
“ IMPORTANT e H

—>‘ ‘4— 6.4

P
‘ Stud for ground
i 240

360

|
o ‘ H#
|
[+] I [ -]
[ -] [ -]
‘ 310 354
-] ‘ ]
|
‘ o= é (03
i 11 i 1 L game H
'.‘. P _‘_ i - .} ‘__
fir / | it
- | A2
ing

Figure 2-2. Outline Drawing of EGS-01 Control
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Install the MPU

IMPORTANT

The speed of the engine is measured to calculate the mixture flow to

for tuning the engine.

1.

Install the Magnetic Pick Up (MPU) on the outside diameter of the flywheel
gear, either through a housing or a bracket. Usually the MPU will be located
in the flywheel housing of the engine.

Look for one of the threaded holes in the flywheel housing that the engine
manufacturer usually prepares for MPU installation.

Set the gap between the MPU and the flywheel gear to between 0.25 and
1.25 mm.

Connect the MPU wires to the EGS-01 control (see the wiring diagram in
Figure 2-8). The MPU wiring of the should always be shielded.

Install the MAT Sensor

The Manifold Air Temperature (MAT) sensor is used for the mixture flow
calculation and for the lambda-correction versus the inlet temperature. (“Manifold
Mixture Temperature sensor” would be a better name for this sensor). An inlet
temperature model will calculate the so-called “Inlet Temp” from the measured
MAT.

For accurate sensing follow these guidelines (see Figure 2-3):

It is important that the sensing element in the nose of the sensor measures
the temperature that represents a good average of the flow. When the nose
of the sensor is too close to the wall, the influence of the temperature of
engine components affects the measurement.

The MAT sensor can be placed close after the throttle, since a model will
calculate the Inlet Temp from the measured MAT. This software feature
compensates for the mixture temperature during the flow from manifold to
cylinder port (see Chapter 6).

Install the MAT sensor (PT100-type) in the inlet manifold of the engine.
Connect the two wires of the sensor which are directly connected to the
PT100 element, see the wiring diagram in Figure 2-6. The other wires are
not required for the EGS-01 control.

CYLINDERHEAD(S)

Incorrect

=
( s s s R s

—_—

[T

i
Correct /

=30 mm

Figure 2-3. MAT Sensor Location

Woodward
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Install the MAP Sensor

The Manifold Absolute Pressure (MAP) Sensor is used for the calculation of the
gas flow to the engine. For reliability reasons you are advised to use two MAP
sensors per engine. For accurate sensing follow these guidelines (refer to Figure
2-4):

e  Mount the MAP sensor at a position where only minor ambient temperature
changes during normal operation can be expected. Use suitable tubing or
hoses. It is not advisable to mount the MAP Sensor directly in or on the
manifold as vibration over long periods of time can seriously affect or
destroy the MAP Sensor. Ambient temperature changes within the manifold
are not insignificant, and therefore can significantly lower the overall
performance of the system.

e  Make the pressure connection of the MAP sensor downstream of the throttle
valve, on the top surface of the manifold to avoid oil, water or dirt entering
the sensor or hose.

¢ Do not mount the pressure connection close to an intake port, direct after
the throttle or at the dead end of the manifold to avoid erratic readings due
to pulsation or strong turbulences.

. It is recommended that each MAP sensor has its own hose. Do not use a
single hose with a T-piece or it will be difficult to locate a broken hose. The
hoses must be mounted in the manifold as close as possible to each other.

e Position the MAP sensor higher than the sample point.

e  Mount the tube or hose continuously rising to avoid trapped oil, water or dirt
in the hose or tube.

—_—

Install the MAP sensor.
2. Connect the wires of the MAP sensor to the EGS-01 control according to
Figure 2-6.

For the allowable temperature specifications, see the sensor
“ IMPORTANT specifications.

CYLINDERHEAD(S)

Manifold —_—
Not Recommended

\ recommended \§ -

Figure 2-4. MAP Sensor Location

R w e w A
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Electrical Connections

Refer to the following Figures for the electrical connections of your EGS-01
control:

Figure 2-6, EGS Wiring Diagram (Terminals 21—40)

Figure 2-8, EGS Wiring Diagram (Terminals 41-60)

Figure 2-9, EGS Wiring Diagram (Terminals 61-80)

Figure 2-10, Examples of Open and Grounded 0—-20 mA Inputs
Figure 2-11, EGS to TecJet Connection

The following input signals can also be transmitted to the EGS-01 through the
"plant communication":

MAT _1 des._power speed bias
MAT_2 meas._power breaker closed
Ch4% des. speed offset des. ign. timing

8 Woodward



Manual 36139 EGS-01 Digital Engine Gas Metering System

& A SEE SPECIFICATIONS

B1 (+) POWER
SUPPLY
82 (0)
L~ ff} SEE TECJET MANUAL
TECJET 1
1 —(+ )A— SUPPLY
A TECJET CONNECTOR
2 ——(—B
G NOT USED
A USED AS SIGNAL TO
R NOT USED ACTIVATE EGS-01 NOM. 0.1A
o T e T T NOT USED GALVANIC ISOLATED RELAY
/ i o MAX 1A 32V
o NOT USED
The——————— NOT USED
S NOT USED
9 (+) TECJET 1 ONOFF @ TECJET CONNECTOR
FUEL ON SHIELDED WIRES TO BE
10 (+) NPUT TWISTED WITH SHIELDED
A GROUND AT ONE END ONLY.
WHEN MOUNTING CONTROL
TO BULKHEAD, USE EXTERNAL
11 CIRCUIT BREAKER TOOTH LOCK WASHER UNDER
ONE SCREWHEAD TO ENSURE
12 RAISE FPROPER GROUNDING.
13 LOWER R=120 Q. INSTALL RESISTOR
COMMON / i \ CLOSE TO EGS TERMINAL
14 ENGINE
OPEN WHEN OK EgﬂECT‘ON A R=120% (SEE TECJET WIRING,
15 MANUAL 36102)
16 CLOSED WHEN OK A
8"\ DIGITAL INPUT: HIGH ONLY WHEN
2 S NOT USED ENGINE IS PARALLEL TO GRID AND
BREAKER IS CLOSED (GENERATOR
18 NOT USED BREAKER AND UTILITY BREAKER)
CANHIGH (ONLY FOR SPEED AND LOAD CONTROL)
19 % h .
t e 'R TECJET CONNECTOR
5ol @ A CAN LOW 'z A(

/;,E, i’t & RAISE/LOWER DIGITAL INPUT

CAN BE USED FOR ONLY ONE
OF THE FOLLOWING:
- DES SPEED (COMPRESSOR CONTROL)
- DES POWER (GENERATOR CONTROL)
SELECTED IN SENSOR SETTINGS
(ONLY FOR SPEED AND LOAD CONTROL)

When the bit rate is set to 250 kbit/s, the maximum length of the
NO E TecJet to EGS cable is 25 meters. Do NOT increase the length of the

cable.

Figure 2-5. EGS Wiring Diagram (Terminals 1-20 and 81-82)
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A LEAN GREEN
21 —’3—, —(+) — SENSOR -—D— + 8 LEANBIURN-SENSOR 0-5 VDC
o H BLack|  |@ / 1\ USE 24 T012 VDC CONVERTER
20 st (=) A N S FOR SUPPLY OF BLACK UEGO CONTROLLER.
“\’ A CONVERTER IS NOT REQUIRED FOR THE
23— — NOT USED BLUE UEGO CONTROLLER.
24F 4 - - NOT USED CURRENT < 30 mA, HOWEVER USE
| > 0.5 mm2 WIRE FOR RELIABILITY
25 L esvc 3 c SELECTABLE 0-5 ¥, 0-10 V OR 0-20 mA.
o / ~
MAP 1
26— (+)8 z %
V) A A TORQUE OR POWER MODE
27— (s — ———A PROGRAMMABLE BY SOFTWARE
05V, 0-10 V OR 0-20méA.
28 + - """ —— —- NOT USED FOR OTHER SENSOR TYPES SEE NOTE.
| HIGH —
29— SPEED A CH4-SIGNAL FROM PLANT
J Low gi} BIAS 0-5 V. 0-10 ¥ OR 0-20 mA
30 — SHOWN FOR VOLTAGE INPUT.
s FOR OTHER SENSOR TYPES SEE NOTE.
kY HIGH | DES-SPEED
A\ | o O
29 LOW = | DES-POWER
AN M fi N ]
53 | \I =) TORQUE (+) ANALOG A3 OR 4 WIRE TYPE SENSOR
| INPUT / i N, IS NOT REQUIRED BECAUSE
POWER
34 Qﬁf (=) (=) —| HIGH ACCURACY 1S NOT NECESSARY
_L R _ ]
35— CH4 (+) ANALOG
L INPUT i i T.TYPE OR K-TYPE THERMO-COUPLES
Ao =10 (=) ———] ARE SELECTABLE BY SOFTWARE.
T USE K-TYPE FOR HIGH TEMPERATURE
37 N A APPLICATIONS,
! i MATT PT100
58 IN GENERATOR CONTROL MODE
pas /_\ THIS IS DES POWER.
39 (F)—_ TTvPE IN COMPRESSOR CONTROL MODE
0 ( )M THIS IS DES SPEED,

ONLY FOR SPEED AND LOAD CONTROL

Figure 2-6. EGS Wiring Diagram (Terminals 21—40)

24 VDC
SENSCR

}

24VDC
SENSOR
USER X
EGS 01 —
— I = 0:20 mA
A —
+ —126 .,
—(33) (35)"
7
- )I_ — (34) (36)
— “ UBERY

EGS-01

USER

| = 0-20 mA
26

®

1

Figure 2-7. Examples of Open and Grounded 0—20 mA Inputs
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41 (+)A —  TECUET2
— m TECJET CONNECTOR
42 (-)B SUPPLY
E . HIGH — A SEE TECJET MANUAL
;o WASTE
) LOw A GATE
44 ,J, — A GALVANIC ISOLATED RELAY
\ HiGH — MAX 1A, 32V
45—
= Low A ACTUATOR 1
46 : A DURING THE FIRST POWER-UP
el . - OR AFTER A POWER SUPPLY
X HIGH — INTERRUPTION BOOTING THE PC
47— TAKES APPROXIMATELY 20 SEC
1 1 Low A ACTUATOR 2 DURING THIS TIME THE EGS WILL
48 ,J; — | NOT BE IN CONTROL OF THE ENGINE.
49 (4 ) EdET2 ONIOFF @ TECJET CONNECTOR
"fF+H—-—-—-———-—-"—-—-——- SPARE
=] A INPUT SIGNAL FROM FLYWHEEL TEETH
E.Q. AMAGNETIC PICKUP 6-60 VAC OR
0-5 VDC SQUARE WAVE
COMMON —
51
— iz A ONLY FOR SPEED AND LOAD CONTROL
57 OPEN WHEN ALARM ALARM
RELAY
53 CLOSED WHEN ALARM
COMMON —
54
OPEN WHEN READY /i\\_ SYSTEM
55 READY
56 CLOSED WHEN READY RELAY
N gy —
57 ) é SPEED SENSOR (6-60 VAC) /
58 | <) 0-5 VDC SQUARE WAVE
—1 1 -
Nt —-——————-—— — — — - SPARE
sOFr————— - —— — - SPARE
Figure 2-8. EGS Wiring Diagram (Terminals 41-60)
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M- NOT USED
RF—— - — — — — — — - NOT USED
FALN Y
63— ) /A\ ] AUXILLIARY
I 1 SUPPLY 5 VDC
64 F———(av)
65 ——— (+5v)C "¢
T N yan o )
MAP 2 | MAX = 100 mA
| o
66 } — (+)B ) B <
» /AN
67 H—+— (ov)a — A
A | MAX = < 30 mA
sFr—————————— — - SPARE SOFTWARE SELECTABLE INPUT 0-5 WV,
0-10 ¥, OR 0-20 mA
_____________ SHOWN FOR SENSOR ...
69 SPARE FOR OTHER SENSORS SEE NOTE.
ior————————"-—-—-—=—- SPARE
A RESET WHEN INPUT IS > 10 mA
FOR > 10 SEC. USE 1k8 RESISTOR
j WITH 24VDC LOGICAL SIGNAL .
7.1 RESET
ANALOG mA INPUT
- SPARE A SOFTWARE SELECTABLE INPUT
o - 0-5 V/, 0-10 V, OR 0-20 mA.
73
] tl ANALOG 1DLE
\ INPUT
74 \T' (=) —|
4 _
75 PN (+] A
I ANALOG
I 2-INPUT
716 ——+—() =]
/77
77 - NOT USED
Br-r—-——— - — — - NOT USED
79 (+) T-TYPE
80 7(_) K-TYPE
Figure 2-9. EGS Wiring Diagram (Terminals 61-80)
24VDC 24 VDC
SENSOR S=NSOR
, USER X l USER
EGS-01 - l EGS-01 ]
; | =020 mA ; I =0-20 mA
A, He o v He
@ =73 (75) @ ={73) 757
67 —er
- )I_ =74 (78) - =i ir6)
E 7 USERY E
Figure 2-10. Examples of Open and Grounded 0—-20 mA Inputs
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TECJET

MAX. RESISTANCE
BETWEEN CONNECTOR
AND GND PLUG = 0.3 Ohm,

(e

WIRES

EGS NO. (COLOR PIN NO.

1 YELLOW + RED |K + D

2 BLACK + BROWN |L

9 BLUE R

19 PINK N

20 GREY \'4
NO CONNECTION ALLOWED
BETWEEN SHIELD AND
CONNECTOR HOUSING

-‘ SHIELD

DETAIL *X*

T—

ya / /
0 “@i ( | N110 1 -
e rili @ PP 29290 PP -

&
GND PLUG
EGS
e
DETAIL *X* —/
Figure 2-11. EGS to TecJet Connection (single TecJet only)
Woodward 13
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Chapter 3.

Monitoring

Introduction

This chapter covers information on control settings, adjustments, installing the
EGS monitor software on your PC and explanation of the monitor program.

Please be aware that the EGS monitor program should be run in MS-

“ IMPORTANT DOS mode, and not in DOS under Windows.

System Requirements

For EGS monitoring, your system has to meet the following system requirements:

e APC, Pentium or faster

e  Astraight or 1:1 cable with 9-pin sub-D female plugs on both ends (see
Figure 3-2)

e Afree DOS communication port

e DOS 6.0 and Windows 95/98.

Install the EGS Monitor Software

Switch your PC on and start to install the EGS monitor software according to the
following steps:

1. Ask your system operator to install a mouse start up command in the
autoexec.bat file of your PC in order to activate the mouse driver in the
MS-DOS mode. In many computers the mouse is only active under
Windows. When you operate the EGS system without a mouse the menus
can be opened using one of the key functions mentioned in the Key
Functions section below.

2. Insert the “EGS monitor software” diskette into your drive A.

3. Start the Window Explorer and go to drive A.

4. Run the EGS.exe file from drive A to unzip and install the EGS monitor
software on the drive C.

5. On the drive C an EGS directory will be made as shown in the example.

C:\EGS\EGS_xx1\EGSMON.EXE
C:\EGS\EGS_xx2\EGSMON.EXE

Version number

14 Woodward
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Run the EGS Monitor Software

1. Restart your PC in the MS-DOS mode, by clicking the button in the
“Start”>"Shutdown” field.

2. After the MS-DOS prompt, type C:\EGS)\, C:\EGS\EGS_xxx and click the
Enter button.

3. Type “‘EGSMON" and click the Enter button, to run the EGS monitor software
program. The screen will show the EGS authorization display as shown in
Figure 3-1.

Another possibility to start in the MS-DOS mode is pressing the F8
IMPORTANT button in the booting period before Windows starts.

It is also possible to make a shortcut to batch file on your PC which forces your
PC to reboot in MS-DOS before running the EGS monitor program. If you make
this shortcut, then you don’t have to perform steps 1 and 2 as listed below.

Press F8.

Select “6” and press enter, so that the MS-DOS prompt appears.

After the MS-DOS prompt, type cd EGS\EGS_XXX (name of the file where
the EGS software is located).

4. Type EGSMON to run the EGS monitor program.

5. Use the key functions as mentioned in the Key Functions section below.

W=

Logging Farameters FProtection Diagno

assword : _

Figure 3-1. EGS Authorization Display
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Key Functions

When you use the EGS monitoring program without a mouse you have to use the
following key functions to open the menus and change parameters.

Key Function

Alt—S Opens the system menu.

Alt—F Opens the File menu.

Alt-V Opens the View menu.

Alt—L Opens the Logging menu.

Alt—P Opens the Parameter menu.

Alt—R Opens the Protection menu.

Alt—D Opens the Diagnosis menu.

Tab key To jump to the next field in any window.

Shift and Tab key [To jump to the previous field in any window.

Space bar To enable / disable the options you require.

Alt-F4 To leave the EGS monitoring program.

“&” key To scroll left through all menus.

“>” key To scroll right through all menus.

“AN key To scroll up through all menus.

“U” key To scroll up through all menus.
Pressing the “|” key or the “@” key can also have the
function to change the option if you are in one of the
windows.

Enter key To confirm the settings or changes.

For quick editing of the tables (edit tables and axes tables), all tables have
features to change the entire table, a row or a column with the following Alt—key
combinations:

Key Function

Alt— A To add a value to all values in the table.

Alt-F To fill the entire table with a value.

Alt—M To multiply all values with a factor.

Alt — X To fill a row with a new value.

Alt-Y To fill a column with a new value.

Alt—D To activate the dashboard
Authorization

The first authorization should be done by a supervisor who is responsible for the
EGS system in your organization. The supervisor can assign other users and
determine their level of access to the system.

The first time the supervisor opens the EGS monitoring program,
“‘SUPERVISOR” must be used as the user name. Press the OK button to open
the monitor software. The EGS system answers with “Do you wish to work with
the EGS now ? “. Press the “ NO “ button, if you are not connected to an EGS
system.

To protect the EGS system against unauthorized changes a password is used.
The supervisor has to click the “System” menu and select the “Change
Password” window. In the “Change Password” window, the supervisor has to
enter the new password twice.

New users can be appointed by the supervisor by clicking the “System” menu
and selecting the “Browse Users” window. Click “Add” then add a user name,
enter a password twice and press “OK”.

16 Woodward
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There are three levels of operation in the EGS:
e  Supervisor: The supervisor can change settings, parameters, start and stop
the logging, assign users, monitor the system, etc.

e Level 1: The same as under Supervisor with the exception of assigning
users

e Level 2: These users can only monitor the system and use the Datalog
functions.

e No password (View Mode): These users can only monitor the system.

Cable Connection

1. Connect a cable between your PC and EGS-01 control. Use a cable with a 9-
pin sub-D female plug on both ends. If the cable has a male and a female
plug, use an adapter with a 9-pin female connector on both ends.

EGS-01

control Laptop or PC

9-pin female
connector

Terminal 10 signal “fuel on”
Power supply

Female, Female,
9 pin, sub-D 9 pin, sub-D
2 2
3 3
5 5

Figure 3-2. Cable Connection

The EGS-01 control only communicates with your PC when the
IMPORTANT supply-voltage and the signal “Fuel On” on terminal 10 are

connected. You can check this using the three green LED’s on the
right side of the PCB. The “Power” and ‘FUEL ON” LED’s should be
on for minimum 15 seconds after the signal “Fuel On” is given.

2. Type user name and password to start the EGS monitoring program. The
EGS-01 control displays the following question: “ Do you wish to work on line
with the EGS now ?” Click the “YES” button to receive the current
parameters from the EGS. If the parameters transmission from the EGS to
your PC is successful the “Information” window appears on the screen.

3. Press the OK button to open the actual engine parameters, settings and to
start the logging function.

Woodward 17
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When there is no communication between the PC and the EGS-01
IMPORTANT control, the system shows the message:” Failed to connect. Retry?”

or “Failed to repair the connection. Retry?” When there is still no

communication after a few retries, check the COM port setting of the

PC by setting port 1,2,3 or 4 to get the correct communication.
Generally most PC’s use COM port 1 as the default COM port.

On-line / Off-line

When you are on-line the engine parameters in the EGS monitor
IMPORTANT program are always identical to the parameters in the EGS control.

If you are going to work on-line you have to decide whether you want to overwrite
the PC parameters (1) or the EGS parameters (2).

1. On-line: parameters EGS - PC (the PC parameters will be overwritten
by the parameter settings of the EGS-01 control).

2. On-line: parameters PC > EGS (the EGS-01 parameters will be
overwritten by the parameter settings of the PC).

During normal EGS monitoring the parameters in the PC (EGS - PC) will almost
always be overwritten. Sending parameters to the EGS-01 control is normally
only done during initial set-up (PC > EGS).

If you send new parameters to the EGS control, the old parameters
N O TI CE are overwritten.

The PC and EGS-01 control must have the same software version. A
IMPORTANT fault box appears if you load a different software version. The fault

box will tell you which software version is valid.

Working off-line is used to prepare the EGS-01 control, such as setting the
default parameters, before you commission the EGS-01 control. By working off-
line you can also load a calibration (parameters from disk) into the EGS monitor
program with the command “File, Open”. This can be used to look at other
(stored) engine calibrations.

“Dashboards” in the EGS monitoring program will only work when
“ IMPORTANT you are on-line.

Menus

On top of the EGS monitor screen is the main menu with the following sub-
menus: System, File, View, Logging, Parameters, Protection and Diagnosis.
Depending on user/level and/or system type, some sub-menus are not
accessible and appear gray. On the bottom of the EGS monitor screen the
monitor version (3.00), engine status: stopped/cranking/running, logging status:
empty/logging/full, and on-line/off-line status are shown.
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System Menu

The “System” menu contains version information of the EGS monitoring system,
installation of new EGS software, and authorization of the EGS system and a
communication window to select the correct COM-port to communicate with your
EGS. The option "Change EGS Password" (see the Authorization section above)
is only accessible on-line, and the option "Install EGS Software" only off line.

Tiew Logging Paramelers ProleclLion Diagnosis HEW

“System File

About EGSHON... F1

ange Fassword...
irowse Users...

N

Install EGS Software_.>
Change EGS Password. ).

n
Communication. .. \ \

ey password
etype password:

“
n
“ User Authorization

Figure 3-3. System Menu
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File Menu

The “File” menu contains the following windows:

Four options (new, open, save and save as) to manipulate the parameter
settings used by the program.

Three options (Dial, Hang Up, Reset Modem) to control the modem
connection.

Two options (Work Online, Work Offline) to control working on-line and off-
line.

A Change System Type window. Select here the type of EGS system
configuration you are going to use for your engine. If you are working on-line
you cannot change the “Change System Type .....” window. It is only
possible when working off-line.

An Options window to select another default directory for saving the EGS
settings files.

A DOS Shell window to go to DOS.

An Exit field to quit the EGS monitoring program.

System Fi1le Uiew Logging Farameters Protection Diagnosis

Hew... Ctrl+H
(pen... Ctrl+d
Save Ctr1+S
Save fis...

Dial...

Hang Up Alt+H

feset Modem...

Work Online Fi
Work Offline Shift+F4

ANge BYSTEM T¥DE. - - \ . Ielephone ook g

Options...
Dos Shell
Exit Alt+Fd

Figure 3-4. File Menu
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View Menu

The “View” menu has the means to view all parameters. The “View" menu
contains the following windows:

The Overall Status window which gives you an overview of the status the
EGS control is functioning.

The Mono Control window which gives you an overview of the measured
and calculated engine and lambda parameters when your EGS system
works in mono control.

The TecJet Bank 1 window which gives an overview of the output
parameters of TecJet 1.

The TecJet Bank 2 window which gives an overview of the output
parameters of TecJet 2. TecJet Bank 2 is only active when you are in stereo
control.

The Diagnosis Alarm Status window which gives you an overview of alarms
that appear during EGS system failures. See also the Diagnosis Menu.

The Engine Alarm Status window which gives you an overview of alarms
that appear during engine alarms. See also the Protection Menu.

The Speed and Load Control Window where all inputs, outputs and
calculations related to speed and load can be found.

The Ignition Timing window has three fields: basic timing, retarding and
actual timing. The basic timing is the normal ignition timing of the engine
received from the Parameters Engine / Engine window. The Basic timing
field changes into desired timing when the timing is through plant
communication. The Timing retarding is the timing from the FireFly to stop
detonation. The Actual timing is the basic timing minus the timing retarding.
The System Type window gives the system which is selected.

The Version Info window gives information on which EGS version you are
using at the moment.

The Measured Values window gives you an overview of all values which the
system measures at the input connections of the EGS system.

For more detailed information about the measured, calculated and output
parameters in some of these windows, see the Explanation of Various
Parameters in the View Menu section below. Speed and Load Control is “grayed”
out if speed control software is not used.

Woodward
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System File

Oversll Status-ﬂ”’p’ﬂﬂ'

Mono Control

Stereo Control

Tecjet bank

Tecjet hank 2

Lilsens ATh e

Dual Fuel

Diagrnosis ARlarm Status L)
Engine Alarm S5Status Shift+F9

Ignition Timing x\\\\ Bhift+FB

Syatem Type
WVersion Information

MERSURED LRLUES

oo Ty o Ty ] wow

o
oo T T B e |

(= [u o= T o |
\'_':j fuce Tum |

Figure 3-5. View Menu, Part 1
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system File

Overall Status
Mono Control
Stereo Control
Tecjet bank 1
Tecjet bank 2
Li=ens o eat
Dual Fuel ,/’f
Diagnosis Alarm Status Fo
Engine ARlarm, Status Shift+F9
gpeed & Load Zontrol Shift+FS

Ignition Timing Sh{izigﬂt
System Type \”””

Version Informatyon

Meapured Values

yatues \
Wingow >
Resplution F3

Dejltec| EGSMON 3 NJO

[ \ \

Faor Help, press F

_‘_I_
REEE

i,

Figure 3-6. View Menu, Part 2
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Logging Menu

The “Logging“ menu contains the following windows:

e The Logging menu has the options to start, stop, clear, or to receive the
logging of parameters when the EGS system is working on-line.

e  The Parameters window gives you the possibility to log data (20
parameters) with the EGS. In the remote logging mode (this is fast, up to
200 Hz) data will be stored first in the RAM of the EGS and then transferred
to the remote monitor PC. With internal logging (1s up to 999s) data is
stored on the SSD of the EGS, so there will not be a loss of data if the
power supply is switched off.

e  The Option window gives you the possibility to make your own logging
default directory.

For more detailed information, see Chapter 6.

ystem File Uiew Logging Parameters Protection Diagnosis

Logging mode

gglng Lnterual time
unber of zamples

Etnp

Clear...
RBeceive. ..

Parameters. ..
Options... >

Figure 3-7. Logging Menu

Parameters Menu

The “Parameters” menu offers you a number of windows in which you can enter
and modify the various parameters, such as engine parameters, air/fuel ratio
parameters, etc. The “Parameters” menu contains the following windows,
explained in this section:

e  “Engine” window

“Fuel System” window

“Fuel Parameters” window

“Air/Fuel Ratio” window

“Speed & Load Control” window (only for EGS with Speed/Load Control)
“Sensor” window

“Transient” window

“Closed Loop” window

“CAN Interface” window

“Plant Communication” window

“Speed and Load Control” window (see Chapter 4) (only for EGS with
Speed/Load Control).
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Variables between square brackets [...] are only used for information
IMPORTANT and are not used in calculations.

Parameters Menu / Engine
The Engine window has four separate windows: Engine, Volumetric Efficiency,
Total Efficiency and Speed Density.

File Wie Logging Farameters Frotection Diag

Engine

Edit Table...

Efficiency m
iency >
Speed -ﬂnsity..?—\

Closed Loop...
CAN Interface...
Plant Communication. .

TempGain
RefTemp
Time Lo warm up engine

Ty

[License holder]
[Compression ratio]
[Number of cylinders]
[Agpiration] TurboCh
[Max. torgue]

[ at]

Engine displacement-total
~bank 1
-bank_2

=
T 5
2

. Speed
. power output

e ]
—hmEg -
W~ =

500 [[1 Tearn vol. eff.’]
750
1000 KEp (]
Corr. Tint (=)
Corrlimit (%)
VeffTint (=)

—— T

Figure 3-8. Parameters Menu / Engine, Part 1
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System File Parameters FProtection Diag

|

Wiew Logging

MARI1d4

Volumetrical Efficiency, W&
Total Efficiency »
Speed density...

Clo=zed Loop...
CAN Interface...

Plant Communication. L ®3rm--
Axis...
Ig9Tm\load 10 20 30 40 50 &0 70 &0 20

12.0
15,0
20.0
e
30.0

Figure 3-9. Parameters Menu / Engine, Part 2
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Parameters Menu / Fuel System

In the Fuel System window you can enter data about the mixing unit and the
TecJet. If two TecJets are being used on one "speed density calculation" where
each TecJet should deliver half the calculated gas flow, the "Dual TecJet" check
box should be enabled.

_ System File View Logging _Parameters Protection Diagnosis

Engine
Fuel System... —————w
Fuel Parameters...

Air/Fuel Ratio
Speed/Load Control
Sensor

[Mixing Unit]
[Throat]
[Profile type]

YYyYvyy

[Profile dimension]

[Number of metering holes]
[Diameter of metering holes]
[Venturi location]

[Throttle wvalwve]

[Tecjet type]

Transient

Closed Loop...
CAN Interface..
Plant Communication...

Dual tecjet

Figure 3-10. Parameters Menu/ Fuel System

Parameters Menu/Fuel Parameters

The Fuel Parameters window gives you the possibility to enter values for the
LHV, density and lambda_stoich. of the gas that will be used. If the check box
"measure CH4%" is enabled, the gas parameters will be calculated depending on
the CH4% signal of an external CH4% analyzer. Only the highlighted parameters
are in use.

_System File View lLogging Parameters Protection Diagnosis MARI 14

Engine
Fuel System...
Fuel Parameters...

Air/Fuel Ratio >

Speed/Load Control >

Sensor L

Transient

Closed Lc

CAN Inter [Gas]

PN T[] easure cm4
Density (kg/m3) @ pn, Tn
Lower heat wvalue (MJ/m3) @ p n, T n
Lambda stoichiometric
CH4 percentage %)
Density (kg/m3) @ pn, T_n
Lower heat value (MJ/m3) @ p_n, T_n
Lambda stoichiometric @ p.n, T_n

Figure 3-11. Parameters Menu / Fuel Parameters
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Parameters Menu / Air Fuel Ratio
The Air/Fuel Ratio window has four separate windows: Ref, Inlet Temp, CH4 and
Potmeter.

In the Ref window you can set the Lambda Ref Axes and edit the Lambda Ref
Table.

In the Inlet Temp window you can set the Lambda Inlet Temp Correction.
In the Potmeter window you can limit the range of the lambda potmeters to

prevent the user adjusting them out of range. The lambda potmeters are located
next to the EGS connections.

— =

View

Stem File Logging Farameters Frotection Diagnosis

E
F
F

ngine

el sSystem...

uel Parameters...
g =21 Ratio

g

FRHEHEEH=2
HHEHEHHHBS
HEHEHEH 2

Potmeter Value Correction

Min:
Mazx:

N EES

CORR. FACTOR

Figure 3-12. Parameters Menu / Air Fuel Ratio

Parameters Menu / Speed/Load Control (only for Speed/Load Control)

The Speed/Load Control menu accesses the following windows:

e The Control Mode window lets you set the type of applications that the
EGS-01 will control (see the Control Modes section in Chapter 4)

e  The Speed Setpoints window enables start, idle and rated speed setpoints
and durations to be set and used (see the Start, Idle, and Rate Speeds
Setpoints and Actuator Output section in Chapter 4)

e  The Load Setpoints window is used to set the maximum engine torque (see
the Compressor Mode, Torque Limiter/Load Setpoints section in Chapter 4)
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o The Throttle Setpoints window is used to define the relation between the
output of the speed or power control and the throttle angle (see the Throttle
Linearization and Calibration section in Chapter 4)

e  The Duty-Cycle Setpoints window lets you calibrate the relationship
between desired throttle angle and the PWM output signal (see the Throttle
Linearization and Calibration section in Chapter 4)

e The Speed Dynamics window is used to set the "gain", "stability" and
(actuator) "compensation" (see the Speed Control Dynamics section in
Chapter 4)

e  The Power Dynamics window is used to enter the "gain versus power"
setting for engines running parallel to the grid in "kW-PID" (see the Power
Control Dynamics section in Chapter 4)

e The Test Mode window
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Figure 3-13. Parameters Menu / Speed/Load Control Part 1
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Parameters Menu / Sensors
In the Sensor window you can enter or modify the settings, such as range, input,
type, etc., of all mentioned sensors.
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Figure 3-15. Parameters Menu / Sensors
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Parameters Menu / Transient
In the Transient window you will find the manifold volume and the number of
dMAP/dt samples which are the parameters to improve transient performance.

DELTA MAP

Figure 3-16. Parameters Menu / Transient

Parameters Menu / Closed Loop
In the Closed Loop windows you can enter or modify the parameters for the
closed loop options.

Engine

GAS QUALITY CLOSED LOOP

Note: P minimum
should be 40% of
maximum
engine power

Figure 3-17. Parameters Menu / Closed Loop
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Parameters Menu / Can Interface

In this window you can change the CAN settings (this is not advised). The
"Protocol 98" should always be enabled, except when using very old TecJets
(with separate electronics boxes, and TecJets with a software version older than
1.05)

Figure 3-18. Parameters Menu / CAN Interface

Woodward 33



EGS-01 Digital Engine Gas Metering System Manual 36139

Parameters Menu / Plant Communication

When "Plant communication" is enabled a list of parameters is sent to another
control system, e.g. for (remote) monitoring systems. Additionally, the EGS can
receive and use various input signals through plant communication (if selected)
(see Figure 3-7).

System

File Uiew Logging Farameters FProtection Diagnosis HEW

Engine

Fuel System...
Fuel Parameters...

GAH Interface...

AirfFuel Ratie b

Speed/Load Contral » nable plant communication
Sensor }

Transient 2 Baudrate 2ol
Closed Loop... $lave address

T S e
30 WS
75 REd.

guitan

O | R

Figure 3-19. Parameters Menu / Plant Communication

Protection Menu

The “Protection” menu offers you a number of windows in which you can add
values to protect your application against overspeed, overload or high
temperatures.

The “Protection” menu contains the following windows:

The Temp Protection window gives you the possibility to set a maximum
temperature for thermocouples 1 and 2 to protect against high
temperatures.

In the PASTOR window you can adjust the level of alarm as a function of
the load level.

In the Overspeed Protection window you can set the maximum engine
speed, maximum time and number of overspeed cycles before alarm.

In the Overload Protection window you can set the maximum engine load
and the maximum time to prevent an overload condition.

The FireFly window for knock detection and protection. You can only make
the FireFly window active if you enable the protocol-98 check box under
“Parameters / CAN Interface”.
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Figure 3-20. Protection Menu
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Diagnosis Menu

The “Diagnosis” menu offers you a number of windows in which you can add
diagnosis information, for example a sensor may operate in a certain range/time
before an alarm comes on.

The “Diagnosis” menu contains the following windows:

e  The “Sensor” window has a number of separate windows in which you can
add the values in where the sensor may operate.

e The “Closed Loop” window. In the Closed Loop window you can add the
max. time for closed loop out of range and to open the loop if the closed
loop error remains. You can only change the “Closed Loop” window if you
have selected a closed loop configuration in the “Change System Type”
window under file menu.

e  The “Lambda Difference Diagnosis” window. In the “Lambda Difference
Diagnosis® window you can set the max. lambda difference and max. time
the lambda difference may be out of range.

e  The Speed Deviation window. In this window you can set the maximum
speed deviation from rated speed. If speed deviation is less than the limit
and the breaker is closed, the control immediately switches from kW control
to speed control. To reset the control the engine must be stopped and the
“breaker closed” signal must be low (i.e. the breaker is open).

e The “TecJet Diagnosis” window. In the “TecJet Diagnosis” window you can
set the max. delta pressure and during time, malfunction when zero gas
pressure is longer then the specified time and a malfunction when the flow is
not reached within a certain time.

e  The “Status” window contains three windows, the status setup window, the
reset options window and the reset alarms window.

e  The “Status Setup” window gives you the possibility to set warnings or
alarms, and to stop the engine when there is an alarm for the listed
malfunctions.

e  The “Reset Options” window gives you the possibility to hold the alarm
status when the system is OK.

° The “Reset Alarms” window, to reset the alarms.

e  The “Plant Communication” window to set a malfunction when
communication is lost. This is only possible when the check box in the
“Parameters / Plant Communication is enabled.
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Figure 3-21. Diagnosis Menu, Part 1

In the “Diagnosis Status Setup” every error code can be set to give, a Warning,
an Alarm, or an Alarm and Stop Engine command. The alarm relay is fail-safe
and is thus is in an activated condition when there is no alarm.

The warning/alarm LED flashes at 1 Hz.

At a Warning: . .
A warning message appears on the monitor.
The warning/Alarm LED is continuously on.
At an Alarm: The alarm relay switches to the “alarm”.

An alarm message appears on the monitor.

At an Alarm and
Engine Stop:

The warning/Alarm LED is continuously on.

The alarm relay switches to the “alarm” position.
An alarm message appears on the monitor.

The throttles and the TecJet close.

The system ready relay switches to the “not ready”.

Woodward
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Figure 3-22. Diagnosis Menu, Part 2
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Explanation of Various Parameters in the View Menu

Mono Engine & Lambda Control

Overview of the measured engine and lambda values and their meaning, if the
EGS system operates in mono control.

Measured Values

n Engine speed

M Engine torque *

Pmech Electrical power of the generator set *

Throttle Throttle valve position

MAP Manifold Absolute Pressure, measured downstream of the throttle
valve.

MAT Manifold Air Temperature, measured downstream of the throttle valve.

* If the torque is measured, than Pmech will be calculated (Pmech = n x M x 2p / 60).
If Pmech is measured, than the engine torque will be calculated (M =P x60/n x 2p)

Calculated Values

Qmn Mixture flow, based on speed, MAP, MAT, cylinders displacement and
volumetric efficiency and related to 1013 mbar and 0 °C conditions.

Qgn Gas flow, based on Qmn, the stoichiometric A/F ratio of the fuel, the
desired lambda and related to 1013 mbar and 0 °C conditions.

Pcal The calculated power of the generator set, based on Qgn, the lower
heat value of the gas and the efficiency of the engine/generator set.

Load The percentage of initiated load, based on the fuel flow to the engine.

Inlet Temp. The inlet temperature is calculated using the measured MAT.

Closed Loop Correction
C corr. Correction factor that corrects Qgn in order to result in a Pcal that is
equal to Pmech.

Lambda Control
Lambda The value shown here is the actual lambda that is measured by the
sensor lambda sensor that is located in the exhaust gas outlet of the engine.
Lambda ref. This value shows the lambda value that has been programmed in the
Parameters/ A/F-Ratio / ref map in order to get the correct emissions
under reference conditions.
Lambda temp. |This value shows the correction factor that has been programmed in
corr. the Parameters/ A/F-Ratio / Inlet Temp correction table in order to get
the correct emissions at changing manifold temperatures.
Lambda CH4 |This value shows the correction factor that has been calculated in

corr. order to get the correct emissions at changing CH4 percentages.
Lambda pot. |This value shows the correction factor that has been set by turning the
corr. small blue potentiometer on the right side of the EGS-01 control.
Lambda This value shows the desired lambda in order to obtain the correct
desired emissions (lambda des = lambda ref. x lambda temp. corr. x lambda

CH4 corr. x Lambda pot. corr.).

The meaning of all values for stereo control are the same as in mono
IMPORTANT control with the exception that it displays the values for two banks.
Another difference is that all values for mono control are displayed in

one window and for stereo control in two windows (one for engine
control and one for lambda control).
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TecJet Bank 1

The TecJet Bank
TecJet 1.

1 window, which gives an overview of the output parameters of

Qgn The from the EGS-01 control requested gas flow command for the
TecJet.

Density The density of the gas through the TecJet as filled out in the
Parameters/Fuel Parameters table and also corrected for the FGT
and FGP. If the CH4% is measured, then the corresponding
interpolated density is shown here and also corrected for FGT.

Delta_P The pressure difference across the TecJet measured by the Delta P
sensor inside the TecJet. (hPa = mbar ).

FGP The Fuel Gas Pressure, measured at the inlet of the TecJet.

FGT The Fuel Gas Temperature.

Pos Ist The actual position of the gas-metering piston inside the TecJet.

Ignition Timing

Overview of the ignition timing values and their meaning.

Basic timing

The basic timing is received from the Parameters Engine / Engine
window. The basic timing field changes into the desired timing when
the timing is through plant communication.

Timing retarding

The timing retarding is received from the FireFly. If no timing-
retarding signal is received, then it displays a 0.

Actual timing

The actual timing is the basic timing minus the timing retarding.
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Chapter 4.

Description of Speed and Load Control
|

General Information

This chapter is only applicable for an EGS with speed and load
“ IMPORTANT control. H

The EGS-01 incorporates a "state of the art" digital speed and load control,
specially designed to control the speed and load of reciprocating gas engines.
The EGS-01 speed control takes into account that the actuator is coupled to the
mixture throttle valve of a turbo charged gas engine, instead to a fuel rack at
diesel engines. The EGS-01 also incorporates an easy-to-use waste-gate control
option.

In this chapter the terms “power control” and kW-PID” are used

“ IMPORTANT instead of “load control”. H
Refer to the Parameters Menu section of Chapter 3 to see the sub-

“ IMPORTANT menu structure. H

The EGS-01 speed control algorithms are similar to those used in the Woodward
ProAct™ speed control. Due to the sophisticated digital engine speed
measurement, the actuator will not react on every speed change caused by
combustion, without making the actuator slow.

The speed control can be used in "isochronous mode" as well as in "droop
mode". When running parallel to the grid the power will be controlled by the
"power control", by comparing the desired and the measured power. Alternatively
the power can be controlled using the speed control with droop and raising or
lowering of the speed setpoint. See Chapter 5 for more detailed information
about control modes.

Applications

The EGS-01 Speed & Load control controls the speed and power of gas engines
in mechanical drive or generator set service, in island or parallel operation.

The engine speed and/or the produced power are controlled with three actuators,
e.g. two mixture throttle valves and one waste-gate control valve. The actuator
outputs of the EGS-01 are PWM "push-pull" outputs, which can be directly
connected to small Flo-Tech™ or Glo-Tech™ actuator/throttle combinations.

See the Actuators section below for all available actuators.

Waste-gate Control

The EGS-01 can also provide "waste-gate control" in the speed or power control
in combination with a Woodward Glo-Tech waste-gate valve connected directly
to the EGS (other valves can also be used, for example ProAct actuator and
driver box).
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With waste-gate control, low loads operation is done with the "waste-gate" fully
open and the mixture throttle valve(s) are used to control the speed or load of the
engine. When the mixture throttle valve(s) are fully open, the waste-gate starts to
close to increase the engine output further. See the Control Dynamics section
below.

Actuators

Actuator Sizes

Woodward ProAct, Flo-Tech and Glo-Tech actuators all have an internal closed
loop position feedback, giving them excellent performance.

The Woodward Flo-Tech small integrated actuator/throttle combinations are
available in the diameters of 33 mm, 48 mm, 60 mm, 68 mm and 75 mm. These
small Flo-Tech sizes can be directly connected to the EGS-01.

The Woodward ProAct actuator can be coupled to a throttle valve shaft directly,
or by using a linkage. The ProAct actuators are used in the ProAct 75 mm, 85
mm and 95 mm, and in the large Flo-Tech 107 mm, 120 mm and 135 mm.

The ProAct actuator uses a separate ProAct driver between the EGS-01 and the
actuator.

For waste-gate application the Glo-Tech actuator/valve combination is available,
and this can be connected directly to the EGS-01 output.

Woodward gas engines specialists can advise you on actuator and throttle sizing
and advise you how to install throttle valves on the engine. More detailed
information can be found in the related actuator manuals. Please contact
Woodward for more information.

Throttle Linearization and Calibration

The EGS-01 incorporates throttle valve linearization maps. When the 75-degree
rotating Woodward actuators are directly coupled to the throttle valve shaft, there
is no need to use progressive linkage systems to compensate for throttle
characteristics.

The EGS-01 speed & load control incorporates three linearization tables/maps,
one for each throttle (see the "Parameters™ - "Speed/Load Control" - "Throttle
Setpoints" sub-menu). With these tables/maps you can define the relation
between the output of the speed or power control and the throttle angle. In
practice, however, a linear table/map works satisfactorily on turbo-charged
engines.

With the "duty cycle setpoints" tables/maps you can calibrate the relationship
between desired throttle angle and the PWM output signal, for each individual

actuator. Using the "test mode", in which you can force any desired throttle
angle, you can check if the duty cycle calibration of the throttle is correct.

Be very careful when using “test mode”. DO NOT USE “test mode”
NOTICE when the engine is running!.
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The test mode will not work when the EGS is in an alarm.
“ IMPORTANT

In the "Parameters" > "Speed/Load Control" - "Throttle Setpoints" sub-menu
(see the Parameters Menu / Speed/Load Control section in Chapter 3), you will
also find the input field for the "start PID% level". This level is the initial throttle
valve position, when during starting; the engine speed exceeds 50 rpm.

The "start ramp rate" is the opening speed of the throttle from the start PID%
position, until "engine running" is detected and the throttle valve position is
controlled by the speed control. More information can be found in the Start, Idle,
and Rated Speed Setpoints and Actuator Output section below.

Electrical Connections EGS-01 and Actuator (or

Driver)
The actuator outputs of the EGS-01 are "push/pull" PWM outputs which switch
between supply and ground. These outputs can be directly connected to one or
more Woodward Flo-Tech actuator/throttle combinations, or one or more ProAct
drivers with ProAct actuators. See Figure 4-1.

EGS-01 EGS-01 PROACT
_— —_ DRIVER
FLOTECH FLOTECH

- g 00 - [ 50

\ i ! ]
SUPRLY O\’/O sUPPLY | Y E] O\’/O

PROACT THROTTLE
SUPPLY SUPPLY ACTUATOR  VALVE

24VDC T 24 VDC il

Figure 4-1. EGS-01 Actuator Outputs

For more detailed information please refer to the related actuator manual.

Control Modes

This section describes the following modes:

e  "Generator Control Mode" against "Compressor Control Mode"

e "Isochronous" against "Droop Mode"

e  "Speed Control Mode" against "Power Control Mode" ("kW-PID").

“Generator Control Mode" against "Compressor Control
Mode"

"Generator Control" has to be selected at (more or less) constant speed
applications. "Compressor control" has to be selected in variable speed
applications (compressor drives).
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When selecting "Generator Control" you can control the following applications:

Single generator in island
operation

Speed control mode (isochronous or droop)

Multiple generator sets in
island operation

Speed control (with droop for load sharing or isochronous with
LSM for load sharing)

Generator set(s) parallel to
the grid

Breaker open

Speed control (for synchronization)

Breaker closed

Power control ("kW-PID")

Alternatively:

Generator set(s) parallel to
the grid

Breaker open

Speed control (for synchronization)

Breaker closed

Speed control (kW-droop method)

e Inisland operation (EGS-breaker signal low) and with the synchronization
option enabled, the speed setpoint can be adjusted using the "speed bias"
input and/or the "raise/lower" inputs.

e In parallel operation and in "kW-PID" mode (circuit breaker closed, EGS-
breaker signal high, and kW-PID enabled) the desired power must be set
using the "desired power" input and/or the "raise/lower" inputs. The desired
load signal is advised to be a 4-20 mA signal.

e  The recommended load signal is 4—20 mA. When using a PLC output
(4-20 mA signal) for the required load signal, galvanic problems can occur.
Make sure the signal is grounded at one side only. It is also possible to
install a galvanic isolator 4-20 mA/4—20 mA between the EGS and the
device that supplies the desired load signal (make sure that one side is
grounded; select this in EGS).

. In parallel operation but in speed control with kW-droop (circuit breaker
closed, but EGS breaker signal low) the power can be changed using the
"speed bias" input and/or the "raise/lower" inputs.

o  With multiple gen-sets in island operation it is also possible to run
isochronous and share the load with load-sharing modules. Synchronization
can be done by using a separate synchronizer connected to the
synchronizer input of the LSM. The output of the LSM is connected to the
speed-bias input of the EGS.

e The discrete input of the EGS-01 can only be used once, either for
synchronizing or for kW_PID.

All mode selections are under the "Parameters" - "Speed/Load control" >
"Control Mode" sub-menu, and all input selections are under the
"Parameters—>"Sensor" sub-menu. These settings can only be changed when
the engine is stopped.

When selecting "Compressor Control mode" it is possible to control the following
variable speed applications in island operation:

Table 4-1.
One engine driving one compressor set Speed control (isochronous or droop)
Multiple engines on one compressor set Speed control with droop

In compressor mode

e  The speed setpoint can be increased from the rated speed setpoint, by the
"desired speed input" and/or using the inputs "raise/lower"

e Itis not possible to select "synchronization enable" or "KW-PID enable".

All mode selections are under the "Parameters" - "Speed/Load Control" >
"Control Mode" sub-menus. This menu cannot be changed when the engine is
running. All input selections are under the "Parameters" - "Sensor" sub-menus.
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"Isochronous" or "Droop Mode"

The EGS-01 speed control can be used in "isochronous mode" or in "droop
mode". For an engine in island operation using "isochronous mode", the engine
speed is kept constant at the desired speed setpoint, independent of engine load.

In "droop mode" the engine speed setpoint decreases with increasing engine
load. See Figure 4-2 where 5% droop is programmed:

1500

1500

1425

1 I
I ]
I I
| |
Speed : Speed :
Setpolnt Isochronous Mode ! Setpoint Droop Mode :
I I
| |
1 I
| |
I I
I I
0 : 0 :
Load % Load % 1009
0 100% %

Figure 4-2. Isochronous or Droop Mode

"Droop mode" can be used when multiple engines are coupled in island
operation and must share the island load together. As a result, the frequency at
full load is slightly lower then at zero load. If you want to keep the frequency
constant in this application, you can add a device that will correct the speed
setpoint of all engines to get a correct frequency. Alternatively you can run one
engine run in "lsochronous mode" and this engine will then hold the bus
frequency at a constant value. The other engines are in droop mode parallel to
the isochronous engine. The droop mode can also be used to improve the
stability of single island operated gas engines.

In compressor mode the amount of droop is based on "load%", where in

generator mode the amount of droop is based on the "measured power" (kW-
droop).

In “droop mode” the speed setpoint is based on actual engine load
“ IMPORTANT and not on actuator angle. H

"Speed Control" against "Power Control" ("kW-PID")

When the circuit breaker is closed and the engine runs parallel to the grid, the
throttle valve(s) will dictate the produced power. When the breaker input of the
EGS-01 is high, the EGS runs in "power control mode". The power control moves
the actuator to equal the measured power and the desired power. When the
breaker signal is low, the EGS-01 expects the circuit breaker to be open, and that
the engine runs in "island operation". In this situation the EGS-01 is in "speed
control mode".

Because the EGS-01 Speed and Load Control uses different control dynamics in
"Power Control mode" ("kW-PID") than in "Speed Control mode", the "Power
Control mode" is preferred to "Speed Control mode" with kW-droop when running
parallel to the grid.
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Normally, in parallel generator set applications, the speed control is only used for
synchronizing to the grid, and if an unexpected speed deviation occurs, such as
a sudden opening of the circuit breaker and an erratic or high EGS-breaker
signal. In this situation the control will switch back immediately from "kW-PID" to
"Speed Control mode". In the event of a speed deviation alarm, this alarm can
only be reset when the engine is stopped.

You can enable droop by entering the required desired droop percentage in the
"LOAD SETPOINTS" menu.

Control Dynamics

General information about Control Techniques

By assuming that a gas engine is a simple linear first order process, it can be
described by the formula:

H(s)=1/(1 +s*7)

This means that if, for example, a load step or a fuel step is applied to an engine
without speed control, the speed change will follow an exponential curve:

Speed (t)=c* (1 —e"")
The time constant (t) of a first order system can be found by measuring the time
required to give 63% of the expected final output change. This can be

understood, because when t = 1, the output is (1 —e™ ) which equals 0.632.

After 3 * 1 the output (speed) is at 95.0% of its final value (see Figure 4-3).

P

tau

Figure 4-3. Output Speed

If a first order process is being controlled, i.e. if an island-operated engine must
be kept at a constant speed even when the load changes, a process controller
that compensates for the slowness () of the process using "D-action" is required.

In this situation the speed control controls the amount of power required to
maintain a desired engine speed even when the engine load changes.
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The EGS-01 uses standard "PID" control techniques in the speed and load

control, and as a result the actuator moves:

e  Proportional to the speed error, this is called "gain"

e To the Derivative of the speed (speed change) called "stability"; this D-
action compensates for the slowness (t) of the engine

o And it will integrate trying to equal the actual speed to the desired speed. (In
the EGS-01 the amount of integrator action is fixed versus gain.)

In addition, the speed control compensates the first order slowness (t) of the
actuator by putting another "D-action" in the signal to the actuator. This is called
actuator "compensation".

As mentioned before, the EGS-01 Speed and Load control incorporates separate
control dynamics for "speed control" and separate control dynamics for "power
control" or "kW-PID".

The parameters which have to be adjusted are the above-mentioned "gain",
"stability" and (actuator) "compensation". Also refer to the Speed Control
Dynamics and Power Control Dynamics sections below for more information
about speed control dynamics and power control dynamics. The Commissioning
section below gives practical tips on the commissioning of the EGS-01 Speed
and Load control.

"Linear Dynamics" vs. "Constant Dynamics"

To improve stability the EGS-01 Speed & Load control offers the possibility to
use the "Linear Dynamics MAP" option. In this mode the "gain" changes linearly
against speed.

When "Linear Dynamics Map" is not selected the "gain" is constant against
speed.

Suggested uses:

Compressor drives Use linear dynamics
Generator drives against the grid Use constant dynamics
Generator drives in island mode Use constant dynamics

Field experience

Isochronous generator control in island mode and the average speed is more or
less constantly lower than the nominal speed. For example engine rpm 1494-
1498 versus 1498-1502 and nominal speed setpoint = 1500, no droop. You are
probably running in linear dynamics. Switching the system to constant dynamics
will bring the average engine speed back up to nominal speed.

Switching between constant dynamics and linear dynamics can be done only
when the engine is stopped. It can be found under "Parameters" - "Speed/Load
Control" - "Control mode” menu.

Speed Control Dynamics

Under the "Parameters" - "Speed/Load Control" > "Speed Dynamics" menu,

you will find the input screens for "gain", "stability" and (actuator) "compensation”
as mentioned before.
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There is no linear relation between the throttle angle and the actual engine load
on most turbocharged gas engines. As a result there is no relation between the
"engine slowness" or (t) and the actuator position, and that is why it is
recommended that the "gain versus load%" table is used instead of the "gain
versus PID%" table. The table that is not used should have its values set at 1.000
since both tables are multiplied.

The gain versus PID% table is exactly the same as that used in the ProAct speed
control.

The "stability" is the D-action that compensates for the time constant (t) of the
engine, and the "compensation"” is the D-action that compensates for the time
constant (t) of the actuator. The actual or guessed time constants for the engine
and the actuator can be filled in at "stability” and at actuator "compensation". The
"gain" and the "stability" are the two major parameters necessary to tune to
obtain a stable engine speed.

Furthermore you will find a speed "window" and a "gain ratio". Outside this speed
"window" the gain will be multiplied by the gain ratio, which improves reaction on
heavy load steps or quick unloading of the engine. The "gain" outside the window
should not be so large that the engine becomes un-stable and stays outside the
speed window continuously.

Remarks:
° The "compensation” and "stability" should be tuned at full load, with correct
A/F ratio.

e Partload performance should be tuned afterwards using the "gain vs.
load%" table. Also, the A/F ratio must be in limits.
e  Without any stability an engine will not become stable.

See also the Before Starting, Set Speed Dynamics section below.

Power Control Dynamics

Under "Parameters" - "Speed/Load Control" - "Power Dynamics" the desired
"gain versus power" for engines running parallel to the grid in "kW-PID" can be
entered. See the Before Starting, Set Power Dynamics section below for practical
default settings.

Furthermore the desired load change [kW/s] can be limited under "Parameters"”
- "Sensors" - "Desired Power".

In power control do not make the gain too low or slow load ramping
IMPORTANT can occur, and load steps can cause an overspeed. See also the

Before Starting, Set Power Dynamics section below.
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Start, Idle, and Rated Speed Setpoints and Actuator
Output

When engine speed is less than 50 rpm, the engine status is "stopped" and the
actuator(s) are closed. From 50 rpm up to the programmable "Engine Running
Speed" the EGS-01 is in the status “starting”. In this status the throttle valve(s)
open from the programmed "Start PID Level" (e.g. 15%) following a
programmable "Start ramp rate" (e.g. 5%/s) until the "Engine Running speed" is
reached (this can be found under "Parameters" > "Speed/Load Control" >
"Speed setpoints”). Normal value is 400 rpm. At that speed the control starts to
control the engine.

After the engine has started it runs at the programmable "idle speed", during the
programmable "idle time". After the "idle time" has elapsed, the setpoint of the
speed control rises within the "idle/rated" time to "rated speed" (see Figure 4-4).

If the idle input is enabled and activated, the engine stays at idle speed.

Engine
starts
turning

Idle/Rated
Ide time time

Rated speed

ldle speed

50

Actuator
output
PID%)

Start
ramp
rate
e e T T |
S PID L [ W

Stopped Starting Running: Running Running

Figure 4-4. Start, Idle and Rated Speed Control

Compressor Mode, Torque Limiter/Load Setpoints

With some compressor applications, where the torque exceeds the maximum
allowable torque at high speeds, the torque of the engine can be limited by
adjusting the maximum throttle angle versus load% in the "Load Setpoints" sub-
menu. The throttle will close to a programmed angle if the torque reaches this
limit, and the decreasing speed limits the engine torque. The engine will stabilize
at its maximum torque limit.
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Overspeed Handling

Never use the overspeed protection for the EGS-01 as the only
overspeed protection of an engine.

The maximum engine speed must be set in the "protection, overspeed" menu.
We advise that maximum engine speed is set just below the setpoint of the
external overspeed protection device.

Every overspeed can be seen in the engine alarm status menu.

As soon as this maximum speed is reached, the TecJet gas valve and the
mixture throttles close immediately and stay closed until the speed has fallen to
50% of the overspeed rpm. After a programmable number of overspeeds within 1
minute, the alarm relay switches. If “stop engine on alarm” is enabled the EGS
stops the engine by closing the TecJet and throttles.

OVERSPEED LIMIT

ENGINE SPEED

1/2 OVERSPEED
LIMIT

TECJETPOSITION f---q pe======= 7 pememmm———— | mmmmmmmm o

(

THROTTLE

Figure 4-5. Overspeed Handling

Commissioning of the EGS-01 Speed and Load
Control

Before Starting, Select Control Mode

Select the correct control modes and the control options in the "Parameters”
->"Speed/Load Control" - "Control Mode" sub-menu.

The droop input screen can be found in the "Parameters" > "Speed/Load
Control" - "Load Setpoints" sub-menu. If droop is used, a default value for the
droop can be between 3 and 5%. See the Control Modes section earlier in this
chapter for more information.
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Before Starting, Select and Check All Inputs

Select the correct "desired power" sensor/input configuration in the "Parameters”
- "Sensor" - "Desired Power" menu. Note that the desired load change can be
limited by setting the ramp limit, e.g. to 180 [kW/s].

For applications with synchronizers select the correct "speed bias" sensor/input
configuration in the "Parameters" > "Sensor" - "Speed Bias" menu. The speed
bias will always be added to the rated speed; for example 0—10 Vdc will give
=25 [rpm] and +25 [rpm]. If discrete inputs are used, the raise and lower limits
can be set, for example, at +25 [rpm] and —25 [rpm] and the raise and lower rate
at, for example, 3 [rpm/s].

Select the correct "desired speed" sensor/input configuration for compressor
applications, in "Parameters" - "Sensor" - "Desired Speed". The desired speed
will always be added to the rated speed; for example 0—10 Vdc will give 0—-500
[rpm] on top of the rated speed. The rated speed can be found under
"Parameters" > "Speed/Load Control" - “speed setpoints”.

Check the correct functioning of all inputs under the "View" > "Measured Values"
menu, especially signals like the breaker signal and measured and desired load
signals.

The "idle input” is an analog input (on terminal 73) which can be configured as a
0-10 Vdc or 0-20 mA input. If you want to use a 24 Vdc logical signal, configure
this input as a mA input, and use an external 10k series resistor to make a 2.4
mA signal.

Before Starting, Set Speed, Throttle, and Duty Cycle Setpoints
Fill in all parameters in the "Parameters" - "Speed/Load Control" = "Speed
Setpoints" sub-menu. See the Start, Idle, and Rated Speed Setpoints and

Actuator Output section above.

Suggested settings:

Idle speed setpoint 1000-1200 rpm
Idle time 3s

Rated speed setpoint 1500-1800 rpm
Idle/Rated time 3s

Engine running speed 350—400 rpm

Fill in the applicable parameters under the "Parameters" - "Speed/Load Control"
- "Throttle Setpoints" sub-menu. See also the Throttle Linearization and
Calibration section above and the actuator or driver manual.

Suggested settings:

Start PID level 10%

Start ramp rate 5%ls

Actuator 1,2 and 3 linear PID% to angle
table/map

If a waste-gate is connected to the EGS-01, you probably want the waste-gate to
be open at low load, and to start closing when the mixture throttle valves are fully
open, until the desired speed or power is reached. In that case you have to fill in
the "Throttle Setpoint" as shown in Figure 4-6.
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Figure 4-6. Throttle Setpoint

Enter the parameters under the "Parameters" - "Speed/Load Control" - "Duty
Cycle" sub-menu to match the PWM value to the throttle angle. "Test Mode" can
be used to check and calibrate the throttle(s). See also the Throttle Linearization
and Calibration section above.

_ Do not use test mode when running the engine.

Commonly used settings for actuators 1, 2 and 3 (depending on the actuator) are

0-75 [°], giving 10-90 [%] duty cycle.

Before Starting, Set Speed Dynamics

Enter the applicable parameters under the "Parameters" - "Speed/Load Control"
- "Speed Dynamics" sub-menu.

Practical default (start) settings are:

Load vs Gain PID% vs Gain Stability 1.80
20 1.000 20 0.020 Compensation 0.25
* 40 1.000 40 0.020 Gain ratio 1.0
60 1.000 * 60 0.020 Window 50
80 1.000 80 0.020
100 1.000 100 0.020
Or:
Load vs Gain PID% vs Gain Stability 4.0
20 1.000 20 0.020 Compensation 0.1
40 1.000 40 0.020 Gain ratio 1.0
60 1.000 60 0.020 Window 50
80 1.000 80 0.020
100 1.000 100 0.020
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®

* EXAMPLE

When the PID% = 60 and engine load = 40% the gains of both tables are
multiplied. So in this example the total gain is 0.020 x 1.000 = 0.020, thus the
gain stays 0.020. This gives the extra option to make the gain also
dependant on engine load.

It is also possible to use only gain vs load. Give all the gains vs PID values a
value of 1.000, and program the desired gains depending on engine load in
the Gain vs Load table.

Typical settings for load vs. gain are:

Load vs Gain PID% vs Gain Stability 1.8
20 1.000 20 0.010 Compensation 0.10
40 1.000 40 0.020 Gain ratio 1.5
60 1.000 60 0.020 Window 40

80 1.000 80 0.022

100 1.000 100 0.022

The (actuator) "compensation” is "D-action" to compensate for the (first order)
response or inertia of the actuator. This value has to be programmed once, using
information of the specific actuator. Alternatively, the actuator response can be
measured when the engine is not running by connecting the position feedback
signal to a chart recorder or a spare analog input of the EGS-01 and using the
data-logging function. Then put a step, for example from 5° to 70°, on the desired
actuator position using Test Mode. Measure the time taken to get 63% of the final
position; this is the time to enter at "compensation".

Before Starting, Set Power Dynamics

Fill in the applicable parameters under the "Parameters" > "Speed/Load Control"
- "Power Dynamics" sub-menu. Practical default settings are:

Power * Gain Compensation 0.25
200 0.1100 Stability 1.15
400 0.1200
600 0.1200
800 0.1400
1000 0.1600
* kW figures given are for example only. Use your own engine kW outputs.

Take note of the following points:

. In power control the gains are much higher than in speed control.

. If the gain is too small slow load ramping and overspeed on a loadstep can
occur.

e  Make sure that maximum desired power is entered correctly in "Parameters"
- "Sensor" > "Measured Power”.

e  The filtering time of the measured power signal can have affect the stability
of the engine load control. A default value of between 0.05 and 0.2 second
is advised.

e  Also enter the filtering time for the measured power under "Parameters" >
"Sensor" > "Measured Power".
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Safety Checks before Starting

Before starting the engine make sure of the following:

e The "Test Mode" option of the EGS-01 must be switched off.

e All emergency stop buttons must function correctly.

e  Check that the main engine overspeed protection is set correctly and that
the EGS overspeed limit is set 50-100 rpm below the main overspeed limit.

e The EGS overload protection must be set to stop the engine if an overload
condition occurs.

e  Check that the throttle valves and/or linkages are calibrated correctly, and
can move freely (move actuators through full stroke).

e  Check that the desired lambda and volumetric efficiency tables are correctly
filled-in.

e  Check that the gas composition, the displacement and the number of teeth,
etc., are correctly filled in. See also Chapter 6 ‘Commissioning” for more
detailed information about commissioning.

e  The transient part of the EGS-01 gas flow calculation, under sub-menu
"Parameters" - "Transient" - "Delta Map" must be correctly filled-in. If the
manifold volume is unknown use engine displacement as an approximate
value. A proven value to use as the number of samples is 7. See also the
Parameters / Transient / Delta MAP section in Chapter 6.

You can limit the maximum throttle angle to a maximum value for the

IMPORTANT first starting by completing the table in the “Parameters” >

“Speed/Load Control” > “Throttle Setpoints” sub-menu using, for

example these settings:

PID [%)] 0 4 8 20 40 60 80 100
Throttle pos.[°]| O 3 6 15 30 30 30 30

After obtaining stable operation, re-adjust the "Throttle Setpoints" to the desired
values, as described in the Before Starting, Setspeed, Throttle, and Duty Cycle
Setpoints section above.

First Time Starting

The engine can now be started for the first time. If the gas line upstream of the
TecJet and gas valves have been purged the first attempt should be successful.

If the A/F-ratio is incorrect the speed control will have difficulty stabilizing the
engine. If the A/F-ratio is almost correct it should be easy to stabilize the engine
at zero load by making small adjustments to the gain. Use the "dashboard
function" when tuning the speed & load control.
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Tuning the Speed Control

All parameters concerning speed control dynamics are in the "Parameters" >
"Speed / Load control" > "Speed dynamics" sub-menu.

Plotting both the engine speed and the actuator position on a chart

IMPORTANT recorder (or using the data logging function of the EGS then using,
for example, a spread sheet to create a graph) can be very useful
when solving stability problems.

It should only be necessary to program the actuator "compensation" value once,
using information of the specific actuator. A value between 0.1 and 0.3 [s] is
normal (see the Before Starting, Set Speed Dynamics section above).

A "gain" value to start with is 0.01 at all loads. Practical gain values will be
between just less than 0.01 and 0.03. Start tuning the speed control with "gain
ratio = 1.00" so the gain is not outside the programmed window (see the Before
Starting, Set Speed Dynamics section above).

The "stability" is a programmable D-action to compensate for the time constant or
inertia of the engine and turbos. Normal values will be between 1-5 [s] where 1
[s] is low D-action and 5 [s] is high D-action (see the Before Starting, Set Speed
Dynamics section above).

The "gain" and "stability" should be tuned with the engine running at full load,
with the correct A/F-ratio or correct exhaust-gas emission:

e Slow hunting can be caused by insufficient stability, and/or too much gain
e Very quick actuator movement is often caused by too much stability

You can use a step speed change to assess the step response and stability of
the system by changing the rated speed in the "Speed Setpoints" sub-menu
from, for example, 1475 to 1525. You also can use load steps at constant speed
to assess the response and stability of the system.

After the full load condition is satisfactory tuned, the part load performance
should be tuned by only changing the "gain" value at part load conditions.

To improve the engine performance during large load changes, you can increase
the gain during these load steps using the "gain ratio". The gain is multiplied by
the "gain ratio" as long as the engine speed is outside the (speed) window. A
practical "gain ratio" setting is between 1.5 and 2, and a practical "window" width
is 40 [rpm]. Make sure that the engine is stable with this higher gain value to
prevent the engine hunting outside the "window".
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Speed and Load Control Troubleshooting

This section is for troubleshooting the speed and load control function of the
EGS-01. For troubleshooting of other EGS-01 functions, see Chapter 8.

Engine is unstable in speed or kW-PID control mode

Problem

Action

Incorrect A/F-parameters or incorrect
speed and load control parameters

Compare parameters of A/F-control and EGS-01 speed
and load control with values from commissioning and
correct if necessary.

Faulty ignition system

Check coils, extenders, spark plugs, HT-leads, wiring,
timing, etc.

Faulty engine

Check the whole engine, including compression, turbos,
leakage's etc.

Faulty speed MPU signal

Check speed MPU and MPU wiring and compare voltage
with value from commissioning.

Faulty actuator or excess free play in
linkage

Check actuators and linkages using "Test Mode" (Makes
sure the engine is stopped)

Filtering time of measured power is too
small or too high

Normal values = 0.01-0.2 s. (Set in "Parameters" >
"Sensor" > "Measured power”.)

Engine continuously in overspeed

Problem

Action

Incorrect A/F-parameters or incorrect
speed and load control parameters

Compare parameters of A/F-control and EGS-01 speed
and load control with values from commissioning and
correct if necessary.

Actuator or throttle valve is stuck in (fully)
open position

Replace throttle valve and/or actuator.

Throttle valve movement is heavy or
restricted

Service or replace the throttle valve.

Actuator does not operate the (correctly
functioning) throttle valve

Check actuator (and driver) and wiring, and replace if
necessary.

Engine does not start

Problem

Action

Incorrect A/F-parameters or incorrect
speed and load control parameters

Compare parameters of A/F-control and EGS-01 speed
and load control with values from commissioning and
correct if necessary.

Throttle(s) will not go to the starting
position

Check speed signal and check if the EGS-01 reaches the
"starting" condition.
Check actuator(s), driver(s), wiring and supply.

Throttle(s) O.K. but no or incorrect gas
flow

See the Engine Will Not Start section in Chapter 8.
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Chapter 5.
EGS Control Description of Operation

Introduction

This chapter gives an overview of the functions which are possible with your
EGS-01 control:

e For Speed and Load Control, see Chapter 4.

For the Air Fuel Ratio part, see Chapter 5.

For the FireFly part, see Chapter 9.

For the PASTOR part, see Chapter 8.

For the Ignition Timing Control, see Chapter 5.

Air Fuel Ratio

A/F Ratio can be expressed as Lambda (A) or in Phi (®). In this manual and in
the monitor and calibration software Woodward only uses the expression
Lambda. Lambda is the air excess factor: air flow / stoichiometric air flow.

Stoichiometric combustion means that the quantity of air in the air/gas mixture is
sufficient to get a complete combustion of the quantity of gas. This ratio is called
lambda =1 (A =1) (A =1/®). The stoichiometric ratio of a gas is expressed as Ast.
The example shows a gas quality where 9.6 liters of air are required to combust

1 liter of gas.
Qair=14417]]
Qair=956]
Q air=8.64 1]
air air air
gas gas gas
A=0.9 r=1 a=1.5

To accurately calculate the gas flow to the engine to get the desired lambda at a
certain load and speed condition of the engine, the speed/density calculation
method is used. The mixture flow to the engine is calculated using the following

formula:
Qmix = n*V*Ve*MAP*Tn /s]
2*60*Pn*MAT
where:
n = engine speed (1/min.)
\% = engine displacement (liters)
Ve = Volumetric Efficiency.
MAP = Manifold Absolute Pressure (kPa)
Tn = 273 °K (normalized temperature)
Pn = 101.3 kPa (normalized pressure)

MAT = Manifold Air (or mixture) Temperature (°K)
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When you have calculated the mixture flow, then the gas flow can be calculated
with the following formula:

Qmix = Qgas + Qair
Qmix = Qgas + ( Qgas * A st *ides )
Qmix=Qgas* ( 1 + Ast*Ades)

Qmix
(1+ Ast*ides)

Qgas =

On V-engines with two butterfly valves you can calculate the mixture and gas
flow for each cylinder bank. This is called “stereo”. The EGS-01 system then
controls two TecJet gas control valves independently.

Control Characteristics

The algorithms used in the EGS-01 control are designed specially for
reciprocating gas engine applications. Similar to what happened in the
automotive industry, carburetors on engines are replaced more and more by
more flexible and more accurate fuel injection systems. To drive an injector on a
gasoline fuel engine, an engine-management system is required. To drive a
TecJet, the low gas-pressure injection valve developed by Woodward, the
EGS-01 is the engine management system.

In the control 3-dimensional maps can be filled to achieve the ideal fuel flow to
the engine under different conditions. The whole power range of gas engines can
be covered because the only variable component is the TecJet.

Variables such as engine displacement, gas composition or volumetric efficiency,
and control modes like stoichiometric, lean burn, closed loop or open loop simply
can be programmed using software.

The EGS-01 control is also capable of compensating for variable gas heat
values, and switching between fuels is possible without changing the hardware.

Sensors to measure engine speed, manifold pressure, manifold mixture
temperature are vital in this system however, and the principles of these sensors
are simple and proven to be reliable. For maximum reliability Woodward has
designed two inputs for MAP sensors. Also in compressor applications the
optimum settings can be made for all speeds. Additional features such as over-
temperature protection, over-fuelling protection, crankshaft angular speed
monitor (PASTOR), and knock detection via the FireFly, are available in the
EGS.

Automatic Volumetric Efficiency Determination

Together with engine speed, the MAP and the MAT, the engine volumetric
efficiency plays a key role in the mixture flow calculation.

Most engine manufacturers know the volumetric efficiency (Ve) of their engines.
If not, you have to fill them out in the field by yourself. For this the EGS-01 control
has a feature to fill the Ve maps automatically. Based on a known gas quality and
stoichiometric ratio of that gas, on the measured lambda in the exhaust of the
engine and based on the gas flow through the TecJet, the EGS-01 control can
calculate the airflow and thus the mixture flow.
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Using the calculated mixture flow at a known cylinder displacement, the speed,
the MAP and MAT, the actual Ve is calculated and stored in the 3-dimensional
map. This map has manifold pressure and engine speed as X and Y-axes.

Qmix_measured = Qgas_measured * (1 + Ast * A_measured)

n*V*Ve*MAP*T.
2*60 " pn* MAT

Qmix_calculated =

_ Qgas_measured * (1 + Ast *A_measured) * 2 * 60 * pn * MAT
n*VvV*MAP* T,

Ve

Automatic Generator Set Efficiency Determination

Normally the electrical power that an engine/generator combination supplies to
the grid or to a plant is measured by sensors. Also, the power that goes into the
engine can be determined by multiplying the gas flow that flows through the
TecJet with the heat value of the gas.

The efficiency is stored by the EGS-01 control in a three-dimensional map, with
ignition timing and load as the x and y-axes.

Ignition Timing Control

The EGS-01 does not control the ignition timing, although the EGS-01 should
always be informed if ignition timing is changed, in order to keep the NOx at the
correct value when using the "GQCL" algorithm. The ignition timing can be
changed by using, for example, a knock detection and controlling system such as
the Woodward FireFly (see Chapter 10).

The following "knock controlling" systems can be implemented:

Retarding the Ignition

The Woodward "FireFly" system is used to detect knocking combustion, and to
retard the ignition using its mA output or the RS-422 communication line, which is
connected to the ignition system. The amount of retarding controlled by the
FireFly is transmitted to the EGS-01 by CAN so the correct total efficiency values
are selected from the "Total Efficiency" map used by the "GQCL" algorithm. This
method keeps the NOXx level constantly low, even when the ignition is retarded.

GQCL control without ignition retarding information brings the NOx back to
almost the same level as just before the retarding.

Load Reduction

In addition to retarding the ignition, the FireFly can reduce engine load to cure
the detonation. If the EGS-01 is controlling the load, the FireFly will force a
certain amount of load reduction (this can be programmed in the FireFly) through
the CAN communication. If the EGS-01 does not control the load, the FireFly can
force the "upper control system" to reduce the load through the RS-422 line of
the FireFly or an mA-output.

It is only possible to use the mA-output of the FireFly once for either:
e Load reduction (for non-Woodward load control)
e Ignition retarding
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For example, the FireFly in combination with EGS and load control can have both
options (ignition retarding and load reduction) where the mA output of the FireFly
can be connected to the ignition system, and can retard the timing. If this is not
sufficient the FireFly will request the EGS by CAN to lower the engine load.

If a non-Woodward device is used for detecting detonation and controlling the
ignition timing of the engine, the timing value should be transferred to the
EGS-01 through the plant communication in order to keep the NOx on a constant
level if the ignition is retarded.

There are no other parameters to set except enabling the FireFly under the

"Protection" > "FireFly" sub-menu, and, if necessary, enabling the "desired
timing input” in the "Parameters" - "Plant Communication" sub-menu.

Please note that "Protocol 98" should be enabled when connecting a
“ IMPORTANT FireFly to the EGS-01 by CAN.

60 Woodward



Manual 36139 EGS-01 Digital Engine Gas Metering System

Chapter 6.

Commissioning

General

To start commissioning you have to make a communication link between the
EGS-01 control and the PC in accordance with the Cable Connection section of
Chapter 3. We recommend, if possible, to re-use a parameter file of the same
engine type, running with the same fuel and operated in the same control mode.
Even if the application is a 100% copy of an earlier application the settings
should be checked before cranking the engine.

Set-up before Starting the Engine

Before you start the engine, check all the parameters in this section.

Variables between square brackets [...] are only used for information
IMPORTANT and are not used in calculations.

Parameters / Engine / Engine

[License holder]
[Compression ratio]
[Number of cylinders]
[Aspiration]

[Maxz. torque]

[ at]

Engine displacement-total
-bank_1
shanki 2

Max. speed

Max. power output

Max. MAP

Ignition timing

Engine displacement |For this mono control application only the total engine displacement
has to be entered.

Max. Speed Used for scaling internal load%. This value is the maximum rated
speed and is not used for overspeed.

Max. Power output Is used for scaling internal load%.

Max. MAP This value equals 100% MAP (used in various tables).

Ignition timing This is the basic ignition timing used to calculate the actual timing
which is used in the “Total Efficiency” table.
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Parameters / Engine / Volumetric Efficiency

Parameters / Engine / Volumetric Efficiency / Axes

Continue the commissioning procedure by checking and/or changing the
Volumetric-efficiency (Ve) parameters. At first the scaling of the axes must be
adjusted. For an optimal resolution it is better to fill the axes close to the reality. It
does not make sense to scale the rpm axes up to 3500 rpm when the engine will
be operated at 1500 rpm. Introducing 1450, 1500, and 1550 rpm are more logical
engine speeds. Also it is better to fill out the MAP table up to 110% MAP. During
overload situations or at a too lean setting of the lambda, the MAP can be higher
than the MAP at rated power and the correct lambda.

[M]= VOLUMETRICAL EFFICIENCY AXIS

10
20
30
40
50
(18]
iU

Parameters / Engine / Volumetric Efficiency / Learn

In this window, the Learn vol. eff.-mode check box must be set. The settings for
the parameters in this field and the instructions on how to apply the automatic
table filling mode are explained in the Parameters/Engine/Volumetric
Efficiency/Edit Table section below.

[7] VOLUMETRICAL EFFICIENCY LEARN
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Parameters / Engine / Volumetric Efficiency / Edit Table

Click the “Edit Table” button to open the Ve table. As a default, Ve value 0.80 can
be used. The table can be left as it is when an earlier engine calibration is
applied. Because in a later stage of the calibration the values in the table will be
automatically optimized by the learn feature of the EGS control, it makes no
sense to put too much effort in collecting the correct values.

Parameters / Engine / Total Efficiency

Parameters / Engine / Total Efficiency / Axes
Check or change the y-axes in the Total Efficiency Axes table. The ignition
advance timing can be changed as required. In this table it is also better to scale

the x-axes to 110% load.

Filter (3)
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Parameters / Engine / Total Efficiency / Learn

The Learn Total. Eff.-mode must be disabled in this window. The settings for the
parameters in this field and the instructions how to apply the automatic table
filling mode are explained in the Parameters/Engine/Volumetric Efficiency/Edit
Table section below.

[] TOTAL EFFICIENCY LEARN

Parameters / Engine / Total Efficiency / Edit Table

The default values in the Total Efficiency Table do not affect the engine
performance in the start-up stage. The value will be used to calculate the
generator set power. A default value of 0.0 at no load and increasing to 0.35 at
full load will be sufficient for system set-up.

TOTAL EFFICIENCY TABLE

Parameters / Engine / Speed Density

In particular during the warming up of a cold engine, but also in normal operating
conditions of the engine, there are differences between the manifold mixture
temperature (the measured MAT) and the actual mixture temperature as it enters
the cylinders (the Inlet Temp). This is caused by engine parts that have a coolant
temperature-related surface temperature, such as the ports of the cylinder head.
The EGS-01 control compensates for the effect of heated-up or cooled-down
mixture by calculating the Inlet Temp using a model. No extra engine
temperature sensors are required for this calculation.

SPEED DENSITY
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Parameters / Fuel System

Choose for single TecJet mode if there is one TecJet per gas flow calculation.
Choose for dual TecJet mode if there are two TecJets per gas flow calculation.

MIXING UNIT & TECJET

Parameters / Fuel Parameters

Enter the gas type (natural, digester, propane, etc.).
Check the box if there is a signal from a CH4-analyser connected to the EGS

control.

Enter the gas data, or enter the gas data of two gas qualities if “Measure CH4”
was enabled. In this mode the EGS control will interpolate between the two
stored gas qualities dependent on the measured CH4 value.

FUEL PARAMETERS

landfill
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Parameters / Air-Fuel Ratio

Parameters / Air/Fuel Ratio / Ref / Axis

Enter or modify the rpm (y ) and the Load ( x ) axes and confirm the values by
clicking the OK button. The filter value is used to improve the transient response.
If the value is too high the fuel mixture can become too rich, which can cause
damage to the engine.

LAMBDA REF AXIS

Parameters / Air/Fuel Ratio / Edit Table
Use an earlier completed table from a similar engine or modify the table by
entering values according to the engine manufacturer’s specifications.

You will damage the engine using stoichiometric settings on a lean
NO TICE burn engine.

For the quick completion of the table the Alt-A-F-M-X and Y features also apply in
this window.

During initial system start-up it might be possible that the speed control does not
match the engine. In practice the correct lambda values can only be filled out
when accurate analyzers for NOX, CO and CO are connected to the engine.
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Parameters / Air/Fuel Ratio / Temp

Keep the Lambda Inlet Temp correction at the default at any temperature, during
initial start up.

Later a fine-tuning of the table can be done once the engine is warmed-up and
also the after cooler water temperature can be varied.

Click the button to open the Dashboard window and check the reading of the
Inlet Temp.

Inlet Temp (°C) CORR. FACTOR

0)
0.
0.
16
il
ik
1Ly

Parameters / Air/Fuel Ratio / Potmeter

The range of the lambda potmeter correction can be limited. During the initial
start up a wide range can be helpful for quick lambda setting changes. However,
because this setting can be changed even by unauthorized people and with a
simple screwdriver, it can be dangerous to leave a wide range programmed in
the system.
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Dependent on the sensitivity for detonation and emission levels, a correction
factor of 1.000 is recommended.

[{]=—— LAMBDA POTMETER CORRECTION

1.000
1.000

Parameters / Sensor

Configure all sensors connected to the EGS-01 control.

Parameters / Transient / Delta MAP

In the Delta MAP window enter the estimated inlet manifold volume. Enter the
average dMAP/dT calculated over 6 samples. Click the “OK” button to close the
window.

DELTA MAP

Parameters / CAN Interface

The default CAN settings are standard and should not be changed (see the
standard settings below). If the CAN settings of the (old type) TecJet are not the
same, change the CAN settings of the TecJet, using the TecJet monitor software,
to match the EGS-01 CAN settings. Do not change the settings of the EGS-01
control.

CAN Protocol 98 should always be enabled except when very old TecJets or
TecJets with software version <1.05 are used. When using a FireFly, CAN
Protocol 98 must be used.
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[(/]== CAN Configuration

Parameters/Plant Communication

In the Plant Communication Setup window:
1. Click the “Enable plant communication” check box to have plant
communication (when available).
2. Click the applicable “Input signal” check boxes that are applicable for
your system.
3. Close this window by clicking the “OK” button.

nable plant communication

Baudrate TA1]I
S$lave address

— Input =igmal Default

;| C°C)
E{ M (°C)
7% e

B ()

Woodward 69



EGS-01 Digital Engine Gas Metering System Manual 36139

Diagnosis / Status / Setup

Before you start the engine, make sure that in the Status Setup Window all
malfunctions are set to “Warning”. Close this window by clicking the “OK” button.

Malf Warning/Alarm Stop engine when alarm

1 System lean Chank_1)

2 System rich Chank_12

10 Hap sensor_1 low signal

11 Map sensoer_1 high signal

13 Hap sensor_1 U_com mode

1] Power sensor low signal

1 PFower sensor high signal

32 Power sensor U_com mode

(1] Hat_1 PT-100 low resistance
[ | Mat_1 PT-100 high resistance
62 Hat_1 U_com mode

70 Thermocouple 1 low signal

Protection / Overspeed

In the Overspeed Protection window fill in the overspeed limit. Close this window
by clicking the “OK” button.

Max engine speed
Max time

Install the UEGO Sensor

1. Connect the UEGO-sensor to the EGS control and a 12 V dc power
supply.
Wiring colors: Orange—12 Vdc supply / Yellow GND supply
Green—signal High (connect to EGS 21)
Black—signal Low (connect to EGS 22)

2. Do not install the sensor in the exhaust yet, but leave it in open air.

“ _ The sensor has a heating element and will become very hot.
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3. After the sensor has been switched on for approximately 5 minutes,
check the signal from the UEGO sensor using a multimeter or the
“View/Measured Values” window (Lambda1). The signal should be 4.50

+0.02 V.
4. If the signal is higher or lower, adjust the UEGO controller (see Figure
6-1).
5. When the signal is 4.50 + 0.02 V, the sensor can be installed in the
exhaust.
OFF
Adjust
IR
Connector Side Wiew

Figure 6-1. UEGO Controller

The newest type of UEGO sensor and controller (colored blue) can
IMPORTANT not be calibrated. This type operates on both 12 Vdc and 24 Vdc.

Communication Check Between EGS and TecJet

1. In the “View Menu”, open the Mono Control window and the TecJet Bank
1 window.

2. In the Mono Control window check the measured values such as MAP
and MAT.

3. Inthe TecJet Bank 1 window check the values for Delta_p, FGP, FGT
and Pos lIst. If these values are at 0.0, then there is no communication
between the EGS and the TecJet.

4. Check the wiring and the CAN settings in the “Parameters Menu” and
open the CAN Interface window.

Parameters/Closed Loop/Gas Quality

Open the “Parameters/Closed Loop/Gas Quality” window and click the check box
to disable closed loop. Click “OK” to exit from this window.
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P minimum should be 40% of maximum engine load.
“ IMPORTANT ’

Parameters/Engine/Volumetric Efficiency/Learn

Open the “Parameters/Engine/Volumetric Efficiency/Learn”, and click the check
box to enable/activate the learn mode.

[¥] VOLUMETRICAL EFFICIENCY LEARN

0.100

By activating the learn volumetric efficiency mode, the system will behave like a
conventional closed loop system, comparing desired and measured lambda and
adjusting the gas flow to make measured lambda equal to desired lambda. By
changing the values at “Kp” and “Corr. Tint” you can speed up or slow down this
closed loop process. By changing the value at “VeffTint” you can speed up or
slow down the updating of the table value (see Determine Speed Density
Temperature Gain and/or Determine Volumetric Efficiency). “CorrLimit” limits the
maximum correction factor.

Normal values for:

Parameter Normal Values
Kp 0.020-0.1

Corr. Tint 5-10s
CorrLimit 10-20%
VeffTint 30-60 s

Click “OK” to exit from this window.
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Parameters/Air Fuel Ratio/Ref/Edit Table

1. Open the “Parameters / Air/Fuel Ratio / Ref / Edit Table” window. For
starting, it is necessary on most engines to use low RefLambda values at
low engine speeds, even at high load percentages.

2. Change the values in the table, if necessary.

3. Close the table by clicking “OK”.

n\Load 10 20 30 40 50 60 70 80 90

0 1 1
250 1.000 1
500 1.000 1
750 1 1
1000 i 1.112 1
1100 i 1.142 1
1200 1. 1 1
1300 ic o3 1
1400 ic 1 1
1450 1c EE: 1
1500 i RE: 1
1550 i R 1
1600 1.1 1.5 1
1700 1.1 1 1
1800 1 1 1

Parameters/Sensors/MAP

1. Open the “Parameters/Sensors/MAP” window and its dashboard, and
check the readings of the MAP sensors.

2. Compare the readings with the FGP reading in the “TECJET BANK1”
window.

The MAP readings are in kPa and the FGP readings are in hPa (1 kPa
“ IMPORTANT =11

3. MAP sensor readings must be within 1 kPa. If the difference is more than
1 kPa check the scaling of the sensors and the mechanical connection of
the sensors.

4. If necessary change the scaling of one or both sensors.

5. Close the dashboard and the MAP SENSORS window by clicking “OK”.

6. Calibrate and Install the Emission Measuring Device.

Start Engine

Start the engine. During cranking, make sure that the EGS receives the rpm
signal from the magnetic pick-up by checking the rpm reading in the Measured
Values section of the Mono Control window. If there is no rpm reading, check the
wiring and adjustment of the MPU. When the gas shut-off valves open check the
Delta_p and FGP readings in the TecJet Bank1 window. If there is no change in
the values for Delta_p and FGP make sure that the shut-off valves are really
opening by measuring pressure downstream of the valves.
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Run the engine without load. If necessary adjust the speed dynamics. Now the
Ccorr value in the Closed Loop Section of the Mono Control window will change
until the “Lambda sensor” = “Lambda desired” in the Lambda control section. If
“Lambda sensor” # "Lambda desired” and Ccorr remains at 1.000, check the
minimum and maximum voltage settings for the Lambda sensor. Go to the
“Diagnosis/Lambda difference” menu and enable the Lambda difference check.
Go to “Diagnosis/Sensor/Lean” and check the settings. If necessary change the
settings and close the window by clicking the OK button. Go back to the
“Diagnosis/Lambda difference” menu, disable the “Lambda difference check”,
and close the window by clicking the OK button.

Check the emissions and if necessary adjust the Ref Lambda table in the
“Parameters / Air/Fuel Ratio / Ref / Edit Table” window. (Accurate emission
control is not required at this moment; it is only necessary to make sure the
engine is not far too lean or far too rich.) Click “Dashboard” button to find out at
which Load % position is in the table to make the change. Close the dashboard
and make the required changes. By opening the dashboard the changes are
transmitted from the PC to the EGS, and the EGS will control air/fuel ratio
according to these changes. If the air/fuel ratio is still not as required close the
dashboard, make the necessary changes and open the dashboard again. If the
emissions are correct (according to the manufacturer’s specification and the
emission regulations) close the dashboard.

Closing the table by clicking “OK” will make the changes permanent. By clicking
“Cancel” the changes can be undone. A dialog box will appear asking if you are
sure you want to undo the changes. Clicking “OK” will restore the table contents
to the original values as they were when the table was opened. Clicking “Cancel’
will make the changes permanent.

800
=lnju}
0oo
100
200
300

Incermediace sectings have been sent Lo the EGS.
Mdo these changes?

Perform the following sections A through L to complete the commissioning.

A. Increase Load

1.
2.

3.
4.
5.

Gradually increase the engine load.

Check the emissions and if necessary make adjustments to the RefLambda
table as described in Start Engine above.

If necessary adjust speed or power dynamics for stable engine operation.
Run the engine at full load until temperatures and emissions are stabilized.
Open the “RefLambda”, the “Volumetric Efficiency” and the “Total Efficiency”
table and their dashboards to make sure the engine is running within the
range of the tables.

If this is not the case, change the axes of the table, as described in the
Parameters / Engine / Total Efficiency section above and in the Parameters /
Air-Fuel Ratio section above. Make sure that you use the same values on the
Load% axis in the “Total Efficiency” table and in the “RefLambda” table.
Open the “Parameters/Sensors/MAP” window and its dashboard.

Check the readings of the MAP sensors. If possible compare the readings
with the readings of another pressure gauge. MAP sensor readings must be
within 1kPa. If the difference is more than 1 kPa, check the scaling of the
sensors and the mechanical connection of the sensors. If necessary change
the scaling of one or both sensors.

Close the dashboard and the MAP SENSORS window by clicking “OK”.

74

Woodward



Manual 36139 EGS-01 Digital Engine Gas Metering System

10. Open the “Parameters/Sensors/Measured Power” window and its dashboard.

11. Check the scaling of the measured power sensor. If necessary change the
scaling.

12. Close the window by clicking “OK”.

13. Continue with the next section.

B. Determine Speed Density Temperature Gain

If the basic settings used are of an identical engine, and the MAT
IMPORTANT sensor at the same location, it is not necessary to determine the
Temperature Gain. You can use the valves as they are and proceed
with the next section.

1. Increase the manifold temperature to the maximum attainable value. This
can be done for example by reducing the water-flow to the aftercooler, or
increasing the temperature of the aftercooler water.

2. Open the “Parameters/Engine/Speed density” window and set the TempGain
to zero. In the “RefTemp” field, enter the actual measured MAT. In the “Time
to warm up engine field”, enter the time it takes the engine to reach a
stabilized coolant temperature.

3. Close the window by clicking “OK”.

TempGain
RefTemp
Time to warm up engine

4. Open the volumetric efficiency table in the “Parameters/Engine/Volumetric
Efficiency/Edit Table” window.

5. Open the dashboard to find out at which position in the table the engine is
running.

6. Adjust the load until MAP is at the maximum MAP% value. The closer to the
table points the engine is running, the better the accuracy of the system.

7. Inthe dashboard click “update” to activate the update of the volumetric
efficiency. Now the volumetric efficiency value is changed automatically until
Ccorr is back at 1.000. Once Ccorr = 1.000 (£0.002) close the dashboard.
The position in the volumetric efficiency table will be updated to the learned
value.

8. Repeat this for the next lower MAP% value.

9. Decrease the manifold temperature to the lowest possible temperature. (It
may be necessary to enrich the mixture to prevent misfire. Change the
RefLambda table to achieve this.)

10. Let the engine run until temperatures are stabilized. By now Ccorr will most
probably have changed to a lower value.

11. Open the “Parameters/Engine/Speed density” window and increase the
TempGain until Ccorr. = 1.000 (x0.002) again. After this, enter the coolant
temperature (in the cylinder head area) at normal engine operation in the
RefTemp field.
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TempGain
RefTemp
Time to warm up engine

(Settings shown are for example only.)

12. Close the window by clicking “OK”.
13. Change the manifold temperature back to the normal temperature.
14. Continue with next section.
C. Determine Volumetric Efficiency
1. Open the volumetric efficiency table in the “Parameters/Engine/Volumetric
Efficiency/Edit Table 1” window.
2. Open the dashboard to find out at which position in the table the engine is
running.
= riie T1IEW Logging Paramecters FrOTECT 101 vlagnosis Winconr | e L BY
n / MAP 30 40 50 &0 70 50 =l 100 110
[M] — DASHEOLRD
n} 0.950 0.3250
250 1499.3
500 110.0%
700 0.540
800 1.000
200 o Q.
1000 738.95 0.
1100 69.07 o. ]
1250 1.000 0.855
1300 0,800 0.535
1400 1.474 0.838
1500 ] g
1s00 0.3535
1700 Update Oo. 5
1500 0

3. Adjust the load until MAP is at the maximum MAP% value.

4. Inthe dashboard click “update” to activate the update of the volumetric
efficiency. Now the volumetric efficiency value is changed automatically until
Ccorr is back at 1.000. Once Ccorr = 1.000 (+0.002), close the dashboard.
The position in the volumetric efficiency table will be updated to the learned
value.

5. Repeat this for all the other MAP% values. If the engine will run at different
speeds during normal operation, repeat for the speeds at which the engine
will be running.

Make sure there are no large differences between adjacent cells. It
may be necessary to change other cells to smooth out large steps
between adjacent cells over a larger number of cells See examples.

IMPORTANT
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Example 1: Large Steps Example 2: Smooth Steps
MAP |20 30 40 MAP |20 30 40
1200 |0.71 0.74 0.77 1200 |0.71 0.74 0.77
1300 |0.71 0.74 0.77 1300 |0.67 0.70 0.73
1400 |0.71 0.74 0.77 1400 |0.64 0.67 0.70
1500 |0.61 0.64 0.67 1500 |0.61 0.64 0.67
1600 |0.61 0.64 0.67 1600 |0.61 0.64 0.67

Underlined values are the learned values as described above.

6. Open the “Parameters/Engine/Volumetric Efficiency/Learn” window and
switch off the learn mode by moving the cursor to the “Learn vol. eff.” field
and pressing the space bar of the computer so that the field reads “No”.

7. Continue with next section.

D. Determine Full Load Ref Lambda and Full Load Total

Efficiency

1. Open the RefLambda table and the dashboard and increase the load again
until Load is at the maximum Load% value and let the temperatures stabilize.
Close the dashboard.

2. Check emissions, and if necessary change the ref lambda values in the area
where the engine is running.

3. Transmit the changes to the EGS control by opening the dashboard and
check emissions again.

4. If necessary make more changes to the table. If emissions are correct, close
dashboard and close the table by clicking “OK”.

5. Open the “Parameters/Engine/Total Efficiency/Learn” window and switch on
the learn total efficiency mode. By changing the TeffTint value it is possible to
speed up or slow down the learn process. Normal value for TeffTint is
20 (s). Close the window by clicking “OK”.

6. Open the Total Efficiency table in the “Parameters/Engine/Total
Efficiency/Edit Table” window.

7. Open the dashboard and click “update”. Now the total efficiency value will be
changed, until Pcal = Pmech. Once Pcal = Pmech, close the dashboard, and
the value in the table will be updated.

8. Repeat these steps for the next lower Load% value.

9. Continue with next section.

E. Determine Inlet Temperature Correction

If the basic settings used are from an identical engine, it is not
IMPORTANT necessary to determine the Inlet Temperature Correction. You can

use the valves as they are and proceed with the next section.

Run the engine at full load and open the “Parameters/Engine/Total
Efficiency/Learn” window and switch off the learn total efficiency mode.
Open the “Parameters/Closed Loop/Gas Quality” window and switch on the
Gas Quality Closed Loop.

Run the engine at different manifold temperatures and adjust the Inlet Temp.
Correction table in the “Parameters/Air/Fuel Ratio/Inlet Temp” window in such a
way that the emissions are correct for all the different manifold temperatures.
Close this window by clicking “OK”.
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Inlet Temp (°C) CORR. FACTOR

(Settings shown are for example only.)

Continue with next section.

F. Determine Part Load Ref Lambda and Part Load Total

Efficiency

1. Open the “Parameters/Closed Loop/Gas Quality” window again and switch
off the Gas Quality Closed Loop.

2. Open the “Parameters/Engine/Total Efficiency/Learn” window and switch the
learn total efficiency mode back on.

3. Open the RefLambda table and the dashboard and reduce the load until
Load is at the desired value. (In this case it is the next lower value compared
to the Load value while determining full load RefLambda.)

4. Check emissions. If necessary change the ref lambda values in the area
where the engine is running.

5. Transmit the changes to the EGS control by opening the dashboard and
check the emissions again. If necessary make more changes to the table. If
emissions are correct, close dashboard and close the table by clicking “OK”.

6. Open the Total Efficiency table in the “Parameters/Engine/Total
Efficiency/Edit Table” window.

7. Open the dashboard and click “update”. Now the total efficiency value will be

changed, until Pcal = Pmech. Once Pcal = Pmech, close the dashboard, and

the value in the table will be updated.

Repeat steps 3 to 7 for all other Load% values.

If there is a signal for ignition timing, determine the total efficiency at the

different load/ignition timings, as described above. If there is no ignition

timing signal, use the same values for the different ignition timings.

© x

Make sure that there are no large differences between adjacent cells.
IMPORTANT If may be necessary to change other cells to smooth out large steps

between adjacent cells over a large number of cells.

Continue with next section.
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G. Change to Gas Quality Closed Loop
Open the “Parameters/Engine/Total Efficiency/Learn” window and switch off the
learn total efficiency mode.

Open the “Parameters/Closed Loop/Gas Quality” window and switch on the Gas
Quality Closed Loop.

Depending on the update rate of the kW signal, it is possible to make the gas
quality closed loop more responsive by increasing the Kp (=Gain) value and/or
decreasing the Corr. Tint value. If sudden changes in gas quality are to be
expected, make the closed loop as fast as possible. However do not make the
closed loop too fast (faster than the update of the kW signal. This may cause
instability and less accurate air/fuel ratio control.

CorrLimit limits the closed loop correction Ccorr (see closed loop correction
section of the Mono Control window), for example 10 % means 1.000 +0.100.
Ccorr can vary from 0.900 to 1.100, if Ccorr reaches the limits, there will be an
alarm/warning. CorrLimit must always be more than the expected change in gas
quality.

P minimum is the minimum calculated power at which the engine has to run
before the gas quality closed loop is enabled. Gas quality closed loop is based
on the total efficiency of the engine and generator. At very low loads the
efficiency calculation and the GQCL algorithm become inaccurate, therefore the
closed loop can only be enabled if the engine is running at more than 30-40 % of
load.

Engine running time is the time after Pminimum (calculated) is reached. After this
time and Pcal > Pminimum the closed loop becomes active. Engine efficiency is
influenced by the various temperatures in the engine (coolant, oil, etc.).
Therefore the closed loop can only be enabled after the time it takes the engine
to reach normal running conditions.

Parameters Normal Values

Kp 0.2-1.0

Corr Tint 20-60 s

CorrLimit 5-15%

P minimum 30-40% of full load kW
Engine running time 120 s

Run the engine at different loads and check the emissions and Ccorr. If
necessary minor adjustments can be made to either the RefLambda table or to
the Total Efficiency table. If the composition of the gas has not changed, Ccorr
should remain between 0.980 and 1.020 if the gas quality closed loop is enabled.

If the engine is running too rich and Ccorr >1.010, enter a slightly lower value in
the Total Efficiency table at the position at which the engine is running. This
makes the mixture leaner and decrease down the Ccorr value.

If the engine is running too lean and Ccorr < 0.990, enter a slightly higher value
in the Total Efficiency table at the position at which the engine is running too
lean. This will richen the mixture and increase the Ccorr value.

In other cases, change the RefLambda table at the position at which the engine
is running too rich or too lean.

Continue with next section.

Woodward 79



EGS-01 Digital Engine Gas Metering System Manual 36139
H. Check Emissions at Different CH4 Levels

This section describes how to check and adjust the emissions at

IMPORTANT different CH4 levels. This section is only applicable to EGS controls
that have an input from a CH4 analyzer and measure CH4 (click the
box “Measure CH4” in the “Parameters/Fuel Parameters” window). If
there is no CH4 signal and/or “MeasureCH4”, then leave the check
box open and proceed with the Setup Diagnosis Warnings/Alarms
section below.

Make sure the CH4 analyzer is calibrated.

Run the engine at full load.

Change the gas quality to bring down the CH4 level, for example by closing

the wells with high CH4 content gas and opening the wells with low CH4

content gas.

4. Check the emissions.

5. If the engine runs too rich or too lean at these low gas qualities, open the
“Parameters/Fuel Parameters” window.

6. If the engine runs too lean, increase the value in the “Lower heat value” field
in the low CH4 percentage (= left) column using small steps, until the
emissions are correct.

7. If the engine runs too rich, decrease the value in the “Lower heat value” field
in the low CH4 percentage (= left) column using small steps, until the
emissions are correct.

8. Close this window by clicking “OK”.

W=

[Gas=] landfill

Density (kg/m3) @ p_n, T_n
Lower heat wvalue (MJ/m3) @ p_n, T_n
Lambda stoichiometric

CH4 percentage (%)

Density (kg/m3) @ p_n, T_n
Lower heat wvalue (MJ/m3) @ p_n, T_n
Lambda stoichiometric @ pn, T_n

9. Change the gas quality to bring up the CH4 level, for example by closing off
the wells with low CH4 content gas and opening the wells with high CH4
content gas.

10. Check the emissions.

11. If the engine runs too rich or too lean at these high gas qualities, open the
“Parameters/Fuel Parameters” window.

12. If the engine runs too lean, increase the value in the “Lower heat value” field
in the high CH4 percentage (= right) column using small steps, until the
emissions are correct.

13. If the engine runs too rich, decrease the value in the “Lower heat value” field
in the high CH4 percentage (= right) column using small steps, until the
emissions are correct.

14. Close this window by clicking “OK”.

Continue with next section.
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l. Optimize Transient Behavior

The transient behavior of a turbo-charged OTTO engine is limited by
IMPORTANT the time required to speed up the turbo-charger. If the measured

Lambda is correct during a transient, then the transient behavior

cannot be improved further, using the transient model. The transient

model will only correct the changing amount of mixture in the intake
manifold.

1. Run the engine at part load, for example 50%.
2. Open the "Parameters/Transient/Delta Map” window.

Inlet manifold wvolume I 1iter

Average dMAP/dT calculated over [} samples

3. Use alean-burn Lambda sensor and a chart recorder, or a fast log to judge
the transient Air/Fuel ratio.

4. Perform a load-step.

5. If transient behavior is not adequate, decrease the value in the “Average
dMAP/dT calculated over..... samples” field. Be careful not to decrease this
value too much or instability can occur.

6. Close the window by clicking the “OK” button.

7. Perform another load step.

8. If transient behavior is still not adequate increase the value in the “Inlet
manifold volume” by approximately 25%.

9. Close the window by clicking the “OK” button and perform another load step.

10. If this gives an improvement, try finding the optimum value, however do not
use a value higher than 2 x the estimated manifold volume.

11. If transient behavior get worse, reduce the original value in the “Inlet manifold
volume” by approximately 25%.

12. Close the window by clicking the “OK” button and perform another load-step.

13. If this gives an improvement, try finding the optimum value, however do not
use a value lower than 0.5 x the estimated manifold volume.

Inlet manifold volume 0.5-2 x real manifold volume
Average dMAP/dT calculated |5-8 samples
over

Continue with next section.

J. Setup Diagnosis Warnings/Alarms

1. Open the “Diagnosis/Sensor” window and set the limits and timers for the
different sensors.

2. Open the “Diagnosis/Closed Loop” window and set the timer. Also choose if
you want to go to open loop in case the closed loop correction is at it's
minimum or maximum value (see “Parameters/Closed Loop/Gas Quality” for
the limit) during the time set.

3. Open the “Diagnosis/Status/Setup” window and for each malfunction select
whether it will cause a warning or an alarm.
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4.

If you choose an alarm, you can decide whether the EGS should switch the
alarm relay and stop the engine if an alarm occurs by closing the TecJet, or
only to switch the alarm relay.

Close the window by clicking the “OK” button.

Malf \UWarningffilarm Stop engine when alarm

10 Map sensor_1 low signal

11 Hap sensor_1 high signal
14 Map sensor_2? low sigmal

15 Map sensor_2? high signal
138 HMAP diff out of range

30 Power sensor low signal

N Power sensor high signal
40 Lambda semnsor_1 low signal
41 Lambda semsor_1 high signal
112 Mapsensor_1 50 ref low

113 Mapsensor_1 50 ref high
114 Hapsensor_2 S5U ref low

7.
8.

K

Save settings file, using “File/Save as” command.

Go off-line, using the “File/Work Offline” command and exit the monitor
program.

Continue with next section.

Enter the EGS Password

Access to the EGS control system during remote monitoring using a modem is
password-protected. The password must first be entered in a new EGS before
remote access using a modem can be used.

Enter the password using the “System/Change EGS password” menu. Type the
new password twice, then close the window by clicking the OK button.

The EGS modem access password is stored in the EGS unit, whereas

“ IMPORTANT the user password for the monitoring program is stored in the PC.

When the password has been entered go off-line, using the “File/Work Offline”
command and exit the monitor program. Continue with next section.

L.

1.
2.

3.
4.

Remove UEGO Sensor and Emission Measuring Device
Stop the engine.

Remove the UEGO sensor from the exhaust and disconnect the UEGO
wiring.

Plug the sensor hole where the UEGO sensor was installed.

Remove the emission analyzer.
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Chapter 7.
Logging

Logging Menu

It is recommended that a “Logging” directory is created to store
IMPORTANT logging data files, and a “Settings‘ directory is created to store
engine calibration files (*.EGS). Create the directories under
“C:\EGS\EGS_nnn\ <directory>".

1. In the Logging menu, click the Parameters field to open the “Logging
Parameters” window.

2. Fill-in the operator name.

3. Fill-in the logging mode.

Logging mode

Logging interval time I[Ij Cs)
Humber of samples (# logs)

Figure 7-1. Logging Parameters

Remote Logging

Remote logging means that the logging data will be stored in the internal RAM
memory of the EGS-01 control.

The RAM memory has the advantage of logging with a fast interval time of 0.005
second, but has the disadvantage that the capacity of this memory is limited to
2250 samples (rows) with 20 parameters (columns) in mono control or 30
parameters in stereo control. Also the stored data will be lost during supply
voltage interruptions.

The remote logging mode is ideal for tuning the transient behavior of an engine
or to check the set for signal and actuator errors.

Internal Logging

Internal logging means that the data will be stored on the solid state disk of the
EGS-01 control.

Using the solid-state memory has the advantage that the data cannot be lost
during supply voltage interruptions. Also the storage capacity is much larger than
the RAM-memory, however the fastest log interval time is one second. The
memory capacity of the solid state disk is about 0.8 Mbytes.
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This leads to the following examples:

Logging duration At time interval
2 hours 1s
7 days 60 s
3 months 800 s

Number of Samples

In the “Remote logging” mode it is not possible to split the number of samples
into more than one file. Files that are made in this mode are stored with the
extension *.log.

In the “Internal logging” mode new files are automatically created after the
programmed number of samples have been reached. It is not convenient to edit
large files in a DOS-editor or in spreadsheet programs. Therefore we recommend

not creating very large files. Files that are made in this mode are stored with the
extensions *.000, *.001, *.003, etc.

Logging Options

During the installation of the EGS-01 monitor software, a directory that is called
C:\EGS_***\DELTEC\LOGGING will be created. It is advisable to store logging
data in this directory.

Use the “Tree” button to select a directory to store the data.

|
=
——
Figure 7-2. Logging Options

On Line with the EGS-01 Control

The Start, Stop, Clear and Receive fields are only active when you are on line
with the EGS-01 control and when the signal “FUEL ON” on terminal 10 is high.

When the control is in the “Remote Logging”-mode the display shows the
remaining percentage of storage capacity.

In the “Internal Logging” mode only the sign “LOGGING” will be displayed.

By clicking the “CLEAR” field, the logging memory of the EGS-01 control will be
made empty.

Receive

In the “Receive” window, a file name for the logging data can be allocated. A file
extension is not required and will be made automatically.
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In both logging modes, the files with the extensions *.PAR and *.EGS will be
created automatically. The logging related parameters will be stored in the *.PAR

file.

The EGS-01 control-related parameters will be stored in the *.EGS file. These
two files will get the same file name as allocated earlier for the logging data files.

STORE LoG FILE(Z) UNDER MAME

Figure 7-3. Logging Data Allocation

Woodward
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Chapter 8.

Troubleshooting

Introduction

This chapter provides a number of examples with faults (questions), possible
causes, and what to do. If your EGS control does not function correctly, check
this chapter to find a solution for your problem or ask Woodward for technical
assistance. The following problems are covered in this chapter:

Unable to work online with EGS

Engine will not start

Engine starts, but will not accelerate

Engine speed unstable

Engine will not accept full load

Engine misfires

Engine detonates

Incorrect NOx emissions

Malfunctions

For troubleshooting information on the speed and load control, see Chapter 4.

Unable to Work Online with EGS

Possible Cause What to do

No power supply to the EGS  |Check for supply voltage to the EGS terminals 81 (+) to 82 (-). Repair
if incorrect.

No Fuel On signal to the EGS |Check for Fuel On voltage to EGS terminal 10 (-) to 82 (-). Repair if
incorrect.

EGS does not boot Replace the EGS.

Incorrect COM port settings Check the COM port settings in SYSTEM menu. Change settings if
incorrect

Faulty interface cable Check cable according to diagram in the Cable Connection section of
Chapter 3. Repair or replace cable if incorrect.

EGS monitor program version |Use the correct version of the monitor program.

different from software version

in the EGS

Engine Will Not Start

Possible Cause What to do

No gas pressure present. Check gas pressure upstream of the gas shut-off valves.

Gas may escape when connecting a pressure gauge. Gas/air
mixture is highly flammable. Make sure there are no open flames,
sparks or hot surface that may ignite the gas/air mixture.

If gas pressure is not present check and repair the gas supply system
upstream of the shut-off valves.
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Possible Cause

What to do

Gas shut-off valves do not
open.

Open the “TecJet bank1” window in the View menu. Check the
FGP value before and during cranking.

Before cranking the FGP value is at ambient absolute pressure.
During cranking the FGP should increase to the ambient
absolute pressure + gas supply gauge pressure.

No increase of the FGP during cranking indicates gas shut-off
valves are not opening. Check and repair shut-off valve
operation.

After cranking, FGP pressure
stays the same value as before
cranking.

Check shut-off valve operation.
TecJet installed in incorrect direction.

No ignition or incorrect ignition
timing.

Check ignition system for correct operation.

EGS alarm or engine alarm
present.

Check the “Diagnosis Alarm Status” and the “Engine Alarm
Status” windows in the View menu. Reset alarms.
If an alarm returns, see Malfunctions below.

No rpm detected by EGS.

Open the “Mono Control” window in View menu. Check rpm
reading during cranking.

If the reading remains at zero, check the voltage and the
frequency of signal on the EGS terminals 57 to 58.

If voltage/frequency incorrect/not present, check wiring for
correct connection.

Check shields for correct installation. Check the sensor for
correct spacing. Make sure there are no metal chips on the end
of the pickup.

Magnetic pickup may have short or open circuit. Perform a
resistance check with the leads disconnected from the EGS.
Should be 100 to 300 Q.

If the voltage/frequency is correct, check the number of teeth
seen by the MPU per engine revolution against the number
entered in the “RPM-TDC SENSOR” window in the
Parameters/Sensor menu. Check the rpm sensor type against
the type entered in the “RPM-TDC SENSOR” window.

Mixture too rich or too lean due
to faulty TecJet operation.

Open the “TECJET BANK1” window in the View menu. Before
cranking check the TecJet position Poslst. Before cranking this
value should be 0.0 mm. A deviation smaller than 2.0 mm will
not have a big influence on starting behavior. If Poslst before
cranking < —-2.0 mm or > 2.0 mm replace the TecJet.

During cranking check Poslst value. After opening shutoff valves
TecJet should open, Poslst should increase.

Fgp — pressure stays the same
value before and during
cranking

Check gas shut off valves.
TecJet connected in opposite direction.

CH4 signal is incorrect. (For
systems using CH4 input only).

Check signal from the CH4 analyzer to the EGS terminals 35 (+)
to 36 (-).

If signal is not present, check the wiring and the CH4 analyzer
operation.

Check calibration of CH4 analyzer.

Compare the CH4 analyzer signal type and the scaling against
values entered in the “CH4 SENSOR” window in the
Parameters/Sensor/CH4 menu.

Desired Lambda too high or
too low.

During cranking check the Lambda desired value. For most
engines this should be approximately 1.00 to 1.25.

If the desired Lambda is incorrect, open the “Lambda Ref table
in the Parameters/Air/Fuel Ratio menu. Change the values in
crank speed area of the table.

»

Actuator does not move to
start position (for systems with
separate speed control).

Refer to speed/load control in Chapter 4.
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Engine Starts, But Will Not Accelerate

Possible Cause

What to do

Mixture too lean.

Check the exhaust emissions.

Even at the correct air/fuel ratio O2% reading may be too high due to
misfire. See Engine Does Not Start in Chapter 4.

Misfire.

Check ignition system for correct operation. Check engine condition.

Engine Speed Unstable

Possible Cause

What to do

Incorrect dynamics
programmed in the speed
control.

Refer to the speed control manual.

Air fuel ratio control unstable.

Check the “Lambda Ref table” in the Parameters/Air/Fuel Ratio
menu for irregularities. Avoid large differences in lambda ref
value in adjacent cells.

Check the Volumetric Efficiency table in the Parameters/Engine
menu for irregularities. Avoid large differences in lambda ref
value in adjacent cells.

Incorrect transient settings.

Improve settings in the “DELTA MAP” window in the
Parameters/Transient menu.

Severe misfire.

Check ignition system and engine condition.

Ignition timing unstable.

Check ignition system for correct operation.

Necessary external wires are
not correctly connected and/or
shielded.

Check the wiring for correct connection and/or improve the shielding.

Actuator and/or driver problem.

Refer to actuator and driver manual.

Engine Will Not Accept Full Load

Possible Cause

What to do

Mixture too lean.

Check the emissions.

Even at the correct air/fuel ratio O2% reading may be too high due to
misfire.

Engine does not operate
correctly.

Engine may be misfiring, waste gate out of adjustment, failed
turbocharger, excessive air filter restriction, general engine condition.

Engine Misfires

Possible Cause

What to do

Mixture too lean.

Check emissions.

Ignition system.

Check ignition system for correct operation.

Even at the correct air/fuel ratio O»% reading may be too high due to
misfire. Check air/fuel ratio by means of UEGO sensor.

Engine condition.

Check engine. Valve clearances, compression end pressure, etc.

Engine Detonates

Possible Cause

What to do

Mixture too rich.

Check emissions. Lean off if necessary.

Ignition timing incorrect

Check real ignition timing. Correct timing if necessary.

Engine overloaded.

Check engine output. Reduce output if necessary.

Detonation caused by
Overload by misfire.

Deposits in combustion chamber. Cure the phenomena that caused
the deposits, and clean the combustion chamber.
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Incorrect NOx Emissions
(NOx emissions now unsatisfactory with "GQCL" operating)

In-service experience has shown that engines running in the Gas Quality Closed
Loop (GQCL) mode show very stable NOx readings, even over longer periods. If
however the engine runs too rich or too lean compared to the original setting, the
following procedure can be followed to get the engine back to that original
setting.

Note that a change of the gas quality or a change in the TecJet
IMPORTANT accuracy will not lead to any change of the NOx reading. Only the

value “correction closed loop” or Ccorr will change.

For future reference make notes of all changes made to the settings.
IMPORTANT Also note the engine running hours.

1. Are you sure that the engine has incorrect NOx emission?

First make sure that the measuring instruments are working correctly.

When a lean-burn gas engine runs too lean, the NOx reading will be too low

and the O, reading will being too high. During rich running the NOx will be

too high and the O, reading will be too low.

If you have a (calibrated) UEGO sensor installed, you can use the lambda

reading as confirmation. Also, the exhaust-gas temperature can give an

indication of the A/F-ratio. If the O, reading is high and fluctuating but the

NOx reading is not low, the cause can be a misfire. The misfire will reduce

the total efficiency and will enrich the engine giving high NOx, but the misfire

also contributes to the high and/or unstable O, readings.
2. Changed or damaged sensors or modified engine:

Check for changes to the following "speed density" related items:

+  MAP-sensors: Position, wiring, tubing, dirt, ambient temperature and
leakage. You can compare the reading with an accurate (barometric)
sensor. For an accurate barometric reading, call your nearest airport.
Compare this reading with your reading, and the values taken during
commissioning.

+ MAT-sensor: Position, dirt, wiring, and installation. You can compare
the reading with other sensors.

+  Volumetric efficiency (Ve): Check if anything has changed on the intake
system such as the flame arrestors, cleaning or adjusting valves, or
cleaning/servicing of the heads.

Check for changes the following "total efficiency" items:

+ Ignition system: Check that the spark plugs, wiring, coils and HT-leads
are serviceable, and finally that the actual ignition timing is correct.
Some ignition systems require re-calibrating after changing various
components to prevent erratic readings on the service tool.

+  Check for changes on the kW-signal, such as wiring, kW-transducer,
the cos® set point or controller.

+  Check for changes at the waste-gate (setting) or the turbo-chargers.

+  Has anything been added or removed from the crank shaft, such as
pumps or gears?

+  Has anything that affects the internal friction losses of the engine been
changed?
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3. Other causes:
If none of the above-mentioned items has caused the change to the exhaust
gas emission, the parameters of the EGS must still be changed to return the
NOx reading to its original value. Use the settings in this table:

NOx |A Ccorr |Reason(s) First solutions Second solutions

OK OK #1.00 |Gas quality has No action Take a gas sample
changed No action Change the TecJet.
TecJet has changed

Too Too <0.99 |Real Total.eff. Clean the engine Lower the V. table and

high low decreased Clean the engine raise the total efficiency
MAP reading is too high table (use ALT-M)

Too Too >1.01 |kW transducer reading |Check the engine Lower the Total.eff table

high low is low Check the kW (use ALT-M) or lower the

transducer LHV.

Instead of changing the Total Efficiency table value (by using Alt-M)
you can change the value of the LHV in the same direction in order to
fine-tune the NOXx. If you increase the LHV ( or increase the
“total.eff”’) the calculated power will increase and the gas-mixture will
become richer due to the increase in Ccorr.

IMPORTANT

Thus by carefully tuning the Volumetric Efficiency and the Total
Efficiency in small steps, e.g. of 0.5% (Alt-M 0.995 or Alt-M 1.005), the
correct NOx level can be attained at a satisfactory Ccorr value.

Malfunctions

Malfunction |Description Remedy
01/03 System lean (bank_1/2). . Calibrate the UEGO sensor at 4.50 V in
ambient air.

. Check the emissions. Check the general
engine condition.

02/04 System rich (bank_1/2). . Calibrate the UEGO sensor at 4.50 V in
ambient air.

. Check the emissions. Check the general
engine condition.

10/14 MAP sensor_1/2 low signal. . Measure the MAP signal on EGS
terminals 26 (+) to 27 (-).

. Check the MAP sensor wiring.

. Replace the MAP sensor. Check the
setting for U_min (I_min) in the MAP
SENSORS DIAGNOSIS window under

) Diagnosis/Sensor menu.

11/15 MAP sensor_1/2 high signal. . Measure the MAP signal on EGS
terminals 26 (+) to 27 (-).

. Check the MAP sensor wiring.

. Replace the MAP sensor. Check the
setting for U_max (I_max) in the MAP
SENSORS DIAGNOSIS window under

) Diagnosis/Sensor menu.

Internal EGS failure. If the failure

persists, replace the EGS unit.

13117 MAP sensor_1/2 U-com mode high.
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Malfunction

Description

Remedy

18

MAP difference out of range.

If only one sensor is used, open the MAP
SENSORS DIAGNOSIS window in the
Diagnosis menu and switch off the
“Enable MAP difference check”.

In the MAP SENSORS window in the
Parameters/Sensor menu, check MAP
readings in dashboard. Compare
readings to pressure measured on
separate gauge to locate faulty sensor.
Check Max difference value in the MAP
SENSORS DIAGNOSIS window in the
Diagnosis/Sensor menu. For most
applications this value should not be
higher than 5 kPa. Check process
connections to sensors. Check the MAP
sensor wiring. Replace the faulty sensor.

20

No rpm signal in PC-104

Internal EGS failure. If failure persists,
replace the EGS unit.

30

Power sensor low signal.

Measure the signal on EGS terminals 33
(+) and 34(-).Check Measured Power
signal wiring to EGS. Check the setting
for U_min (I_min) in POWER SENSOR
DIAGNOSIS window in the
Diagnosis/Sensor menu.

31

Power sensor high signal.

Measure the signal on EGS terminals33
(+) and 34(-).

Check Measured Power signal wiring to
EGS. Check the setting for U_max
(I_max) in POWER SENSOR
DIAGNOSIS window in
Diagnosis/Sensor menu.

32

Power sensor U_com mode high.

This can be due to galvanic problems.
Connect a galvanic isolator between the
EGS and the power signal. When an mA
signal is used make sure it is grounded
on one side. If the failure persists,
replace the EGS unit.

40

Lambda sensor_1 low signal.

If no lambda sensor installed, open the
LAMBDA DIFFERENCE DIAGNOSIS
window in the Diagnosis menu. Switch
off “Lambda difference check enable”.
Calibrate UEGO sensor at 4.50 V in
ambient air.

Measure the signal on EGS terminals 21
(+) and 22(-).

Check the lambda sensor wiring to the
EGS. Replace the UEGO sensor and/or
UEGO controller.

Check setting for U_min in LEAN
SENSOR DIAGNOSIS window in
Diagnosis/Sensor menu.
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Malfunction

Description

Remedy

41

Lambda sensor_1 high signal.

. If no lambda sensor installed, open
LAMBDA DIFFERENCE DIAGNOSIS
window in DIAGNOSIS menu. Switch of
“Lambda difference check enable”.

o Calibrate the UEGO sensor at 4.50 V in
ambient air.

. Measure the signal on EGS terminals21
(+) and 22(-).

. Check the lambda sensor wiring to the
EGS. Replace the UEGO sensor and/or
UEGO controller.

. Check setting for U_max in LEAN
SENSOR DIAGNOSIS window in
Diagnosis/Sensor menu.

42 Lambda sensor_1 U_com mode . Internal EGS failure. If the failure

high. persists, replace the EGS unit.

60 MAT_1 PT 100 low resistance. . Measure the PT-100 resistance
(disconnect wiring from EGS before
measuring).

. Check the MAT sensor wiring to the
EGS. Replace the MAT sensor.

o Check setting for R_min in MAT
SENSOR DIAGNOSIS window in
Diagnosis/Sensor menu.

61 MAT_1 PT 100 high resistance. After the engine has stopped heat conduction
can cause the MAT sensor temperature to
increase to the engine jacket water
temperature. Make sure that the R_max for
the MAT sensor is set sufficiently high to
prevent MAT alarms when the engine is
stopped.

. Measure the PT-100 resistance
(disconnect wiring from EGS terminals
37/38 before measuring).

. Check the MAT sensor wiring to the
EGS.

. Replace the MAT sensor.

. Check setting for R_max in MAT
SENSOR DIAGNOSIS window in
Diagnosis /Sensor menu.

70/73 Thermocouple_1/2 low signal. . If no thermocouples installed, open the

TEMP PROTECTION window in
Protection menu. Switch off “Enable
thermocouple”.

. Measure signal on EGS terminals 39/79
(+) and 40/80(-).

. Check the thermocouple wiring to the
EGS. Replace the thermocouple.

. Check setting for U_min in the
THERMOCOUPLE DIAGNOSIS window
in Diagnosis/Sensor menu.
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Malfunction

Description

Remedy

71/74

Thermocouple_1/2 high signal.

If no thermocouples installed, open
TEMP PROTECTION window in
Protection menu. Switch off “Enable
thermocouple”.

Measure signal on EGS terminals 39/79
(+) and 40/80(-).

Check the thermocouple wiring to the
EGS. Replace the thermocouple.
Check setting for U_max in
THERMOCOUPLE DIAGNOSIS window
in Diagnosis/Sensor menu.

72/75

Thermocouple_1/2 U_com mode
high.

Internal EGS failure. If the failure
persists, replace the EGS unit.

80

CH4 sensor low signal.

If CH4 input is not used, open the FUEL
PARAMETERS window in Parameters
menu, switch off “Measure CH4” and
make sure correct fuel parameters are
used.

Measure signal on EGS terminals 35 (+)
and 36 (-).

Check the CH4 signal wiring to the EGS.
Check the CH4 analyzer for correct
operation.

Check setting for U_min (I_min) in the
CH4 SENSOR DIAGNOSIS window in
Diagnosis/Sensor menu.

81

CH4 sensor high signal.

If CH4 input is not used, open the FUEL
PARAMETERS window in Parameters
menu, switch off “Measure CH4” and
make sure correct fuel parameters are
used.

Measure signal on EGS terminals 35 (+)
and 36 (-). Check the CH4 signal wiring
to the EGS.

Check the CH4 analyzer for correct
operation.

Check setting for U_max (I_max) in the
CH4 SENSOR DIAGNOSIS window in
Diagnosis/Sensor menu.

82

CH4 sensor U_com mode high.

Internal EGS failure. This alarm can be
caused by galvanic problems. Install a
galvanic isolator between analyzer and
EGS. When an mA signal is used make
sure it is grounded on one side. If the
failure persists, replace the EGS unit.

90

Desired power input low signal.

Measure the desired power signal on
EGS terminals 31 (+) to 32 (-).

Check desired power signal wiring.
Check the settings in the DESIRED
POWER window under
Parameters/Sensor menu.

Check the settings for U_min (I_min) in
the DESIRED POWER DIAGNOSIS
window under Diagnosis/Sensor menu.
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Malfunction

Description

Remedy

91

Desired power input high signal.

Measure the desired power signal on
EGS terminals 31 (+) to 32 (-).

Check desired power signal wiring.
Check the settings in the DESIRED
POWER window under
Parameters/Sensor menu.

Check the settings for U_max (I_max) in
the DESIRED POWER DIAGNOSIS
window under Diagnosis/Sensor menu.

92

Desired power input U_com mode
high.

Internal EGS failure. This alarm can be
caused by galvanic problems. Install a
galvanic isolator between analyzer and
EGS. When an mA signal is used make
sure it is grounded on one side. If the
failure persists, replace the EGS unit.

110

Aux 5V ref low.

If auxiliary 5 V reference output is not
used, open the AUX 5V REF
DIAGNOSIS window in Diagnosis/
Sensor menu and switch off “Use
auxiliary ref”.

If auxiliary 5 V reference output is used,
measure the current drawn from the EGS
terminals 63 (+) and 64 (-), maximum
current is 100 mA.

Check the wiring connected to EGS
terminals 63 and 64.

Replace the EGS unit if necessary.

111

Aux 5V ref high.

If auxiliary 5 V reference output is not
used, open the AUX 5V REF
DIAGNOSIS window in Diagnosis/
Sensor menu and switch off “Use
auxiliary ref”.

If auxiliary 5 V reference output is used,
make sure there is no higher voltage
supplied to the EGS terminals 63 (+) and
64 (-).

Replace the EGS unit if necessary.

112/114

MAP sensor_1/2 5V ref low.

If the MAP sensors don’t use 5V
reference voltage, open MAP SENSORS
DIAGNOSIS window in
Diagnosis/Sensor menu and switch off
“Use reference voltage”. Check the MAP
sensor wiring to the EGS. Check the
MAP sensor operation, replace if
necessary. Replace the EGS unit if
necessary.

113/115

MAP sensor_1/2 5V ref high.

If the MAP sensors don’t use 5V
reference voltage, open MAP SENSORS
DIAGNOSIS window in
Diagnosis/Sensor menu and switch off
“Use reference voltage”.

Check the MAP sensor wiring to the
EGS.

Check the MAP sensor operation,
replace if necessary.

Replace the EGS unit if necessary.
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Malfunction

Description

Remedy

130

Closed loop corr>max.

If closed loop becomes less than
maximum value while engine is idling
and EGS is set-up for GQCL the “Engine
running time” may be set too low. A
normal time is 100—-200 seconds.

Check if power signal coming from
generator or real power sensor scaling is
still the same as during commissioning.
Check the TecJet(s) for correct
operation.

Check the engine for correct operation.
Check the gas quality.

Check the CH4 analyzer for correct
operation.

Check the CH4 signal and wiring.

Check closed loop limits in Gas Quality
Closed Loop window in Parameters
menu.

131

Closed loop corr<min.

Check if power signal coming from
generator or real power sensor scaling is
still the same as during commissioning.
Check the TecJet(s) for correct
operation.

Check the engine for correct operation.
Check the gas quality.

Check the CH4 analyzer for correct
operation.

Check CH4 signal and wiring.

Check closed loop limits in GAS
QUALITY CLOSED LOOP window in
Parameters menu.

140

Lambda sensor not ready time out.

If no lambda sensor installed, open the
LAMBDA DIFFERENCE DIAGNOSIS
window in Diagnosis menu. Switch off
“Lambda difference check enable”.
Measure signal on EGS terminals 21 (+)
and 22(-).

Replace the UEGO sensor and/or
controller.

Check setting for U_min, U_max and the
time at “Malfunction if sensor not ready
after:” in LEAN SENSOR DIAGNOSIS
window in Diagnosis/ Sensor menu.

150

CAN controller error status.

Makes sure the grounding between the
EGS and TecJet is correct, and uses the
special ground connections. Make sure
the shield of the TecJet cable is
connected to the EGS ground
connection.

Check the CAN wiring. Make sure the
120 Q “end of line” resistors are present.
Check CAN settings in the CAN Interface
window in the Parameters menu.

Check CAN settings in TecJet(s) and
FireFly. Check the TecJet(s) and FireFly
for correct operation.

Disconnect the TecJet connector and
check using an ohmmeter that its shield
has no connection to the connector on
the cable.

Woodward
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Malfunction

Description

Remedy

151

CAN controller bus off status.

Check the CAN wiring. Make sure the
120 Q “end of line” resistors are present.
Check CAN settings in the CAN Interface
window in the Parameters menu.

Check CAN settings in TecJet(s) and
FireFly. Check the TecJet(s) and FireFly
for correct operation.

160 PC-104 failure. o Check power supply and “fuel on”
sequence, make sure power supply is
present before “fuel on” is switched on
and after “fuel on” is switched off.

. Internal EGS failure.
° If failure persists, replace the EGS unit.

161 PC-104 software hang. . See remedy malfunction 160.

162 Dual ported RAM failure. . See remedy malfunction 160.

170 Micro controller failure. . Check power supply and “fuel on”
sequence, make sure power supply is
present before “fuel on” is switched on
and after “fuel on” is switched off.

o Internal EGS failure.
° If failure persists, replace the EGS unit.

171 Micro controller RAM failure. . See remedy malfunction 170.

172 EPROM checksum error. o See remedy malfunction 170.

173 E2prom checksum error. . See remedy malfunction 170.

174 Dual ported RAM failure. ) See remedy malfunction 170.

175 Micro-controller software hang up. |e See remedy malfunction 170.

180 Supply voltage low. . Check power supply voltage.

. Malfunction occurs if supply voltage is
lower than 10 V during 1 minute.

181 Supply voltage high. . Check power supply voltage.

. Malfunction occurs if supply voltage is
higher than 32 V during 1 minute.

182 Ambient temperature low. o Check temperature in control panel in
which the EGS is installed.

. Malfunction occurs if temperature is
lower than 0 °C (32 °F) during 1 minute.
Install heater if necessary.

183 Ambient temperature high. . Check temperature in control panel in
which the EGS is installed.

. Malfunction occurs if temperature is
higher than 70 °C (160 °F) during 1
minute. Improve ventilation if necessary.

190 5 Volt digital low. . Internal EGS failure. If failure persists,
replace the EGS unit.

191 5 Volt digital high. o See remedy malfunction 190.

192 +8.5 Volt supply low. o See remedy malfunction 190.

193 +8.5 Volt supply high. ° See remedy malfunction 190.

194 +18 Volt supply low. ° See remedy malfunction 190.

195 +18 Volt supply high. ° See remedy malfunction 190.

196 -12 Volt supply low. . See remedy malfunction 190.

197 -12 Volt supply high. o See remedy malfunction 190.

198 V_high supply low. o See remedy malfunction 190.

199 V_high supply high. ° See remedy malfunction 190.

200 SPC processor failure. . Internal EGS failure. If failure persists,
replace the EGS unit.

201 SPC board RAM failure. o Internal EGS failure. If failure persists,
replace the EGS unit.

202 SPC board Flash EPROM failure. |e Internal EGS failure. If failure persists,

replace the EGS unit.
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Malfunction |Description Remedy

203 No rpm signal on SPC board. . Open EGS unit and check flat-cable
connection between main circuit board
and Speed Control printed circuit board.

204 Speed deviation. . Check “breaker closed” signal on EGS

pin 11. Make sure signal is low when
engine is not running parallel to utility.

. Check settings in SPEED DEVIATION
DIAGNOSIS window under Diagnosis
menu, if necessary increase setting.

. Check Rated Speed setpoint in
Parameters/Speed/Load Control/Speed
Setpoints menu.

To reset this malfunction, engine must be
stopped and “breaker closed” signal must be
low.

210

Desired speed input low signal.

. Measure the desired speed signal on
EGS terminals 31 (+) to 32 (-).

o Check desired speed signal wiring.

. Check the settings in the DESIRED
SPEED window under
Parameters/Sensor menu.

. Check the settings for U_min (I_min) in
the DESIRED SPEED DIAGNOSIS
window under Diagnosis/Sensor menu.

211

Desired speed input high signal.

. Measure the desired speed signal on
EGS terminals 31 (+) to 32 (-).

. Check desired speed signal wiring.

. Check the settings in the DESIRED
SPEED window under
Parameters/Sensor menu.

. Check the settings for U_max (I_max) in
the DESIRED SPEED DIAGNOSIS
window under Diagnosis/Sensor menu.

212

Desired speed input U_com. mode
high

. Internal EGS failure. This alarm can be
caused by galvanic problems. Install a
galvanic isolator between analyzer and
EGS. Make sure that mA signal is
grounded on one side. If the failure
persists, replace the EGS unit.

220

Speed bias input low signal.

o Measure the speed bias signal on EGS
terminals 29 (+) to 30 (-).

. Check speed bias signal wiring.

. Check the settings in the SPEED BIAS
window under Parameters/Sensor menu.

. Check the settings for U_min (I_min) in
the SPEED BIAS DIAGNOSIS window
under Diagnosis/Sensor menu.

221

Speed bias input high signal.

. Measure the speed bias signal on EGS
terminals 29 (+) to 30 (-).

o Check speed bias signal wiring.

. Check the settings in the SPEED BIAS
window under Parameters/Sensor menu.

. Check the settings for U_max (I_max) in
the SPEED BIAS DIAGNOSIS window
under Diagnosis/Sensor menu.

222

Speed bias input U_com. mode
high.

o Internal EGS failure. This alarm can be
caused by galvanic problems. Install a
galvanic isolator between analyzer and
EGS. Make sure that mA signal is
grounded on one side. If the failure
persists, replace the EGS unit.

Woodward
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Malfunction |Description Remedy

230/240 TecJet_1/2 no communication. . Check the TecJet software version. If
version is 1.04 or lower, open the CAN
Interface window in the Parameters
menu and switch off the “Enable CAN
protocol 98” option. If the TecJet has
1.05 or higher software version, the
“Enable CAN protocol 98” option must be
switched on.

. Refer to TecJet manual for details.

. Check CAN wiring. Make sure the 120 Q
“end of line” resistors are present.

o Check CAN settings in the CAN
INTERFACE window in the Parameters
menu.

. Check the CAN settings in the TecJet
(see malfunction 150).

. Check the TecJet for correct operation.

° Refer to TecJet manual.

231/241 TecJet_1/2 zero gas pressure. . Check the Delta_p in the TECJET BANK
1 window.

. Check the gas supply to TecJet,
measure actual pressures upstream and
downstream of the TecJet.

. Refer to TecJet manual.

232/242 TecJet_1/2 high delta pressure. . Check the Delta_p in the TECJET BANK
1 window.

. Check the actual pressures before and
after the TecJet.

. Check the setting of pressure regulator
upstream of the TecJet.

. Check the setting for Max. delta pressure
in the TECJET DIAGNOSIS window in
the Diagnosis menu and compare this
setting with the TecJet specifications.

. Refer to TecJet manual.

233/243 TecJet_1/2 flow not reached. . Check that holes in the insert are not
blocked due to oil coming from the
breather system.

. Check the gas supply to the TecJet,
measure gas pressure upstream of the
TecJet. Check the gas filter.

. Check the gas supply for obstructions.

Check the engine output, make sure

engine is not overloaded.

o Check the engine for correct operation.
. Check the gas quality.
o Refer to TecJet manual.

234/244 TecJet_1/2 malfunction. . Refer to TecJet manual.

235/245 TecJet_1/2 closed due to error. . Refer to TecJet manual.
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Malfunction |Description Remedy

270 No plant communication. . If plant communication is not used, open
the PLANT COMMUNICATION SETUP
window in the Parameter menu and
switch off the “Enable plant
communication” option.

. Check the plant communication wiring.
Check the settings for “Baud rate” and
“Slave address” in the PLANT
COMMUNICATION SETUP window in
the Parameter menu. Check the time
setting in the COMMUNICATION
DIAGNOSTICS window in the Diagnosis
menu and compare to the update rate of
the plant communication. Check the
device that is connected to EGS for plant
communication for correct operation.

280/285 FireFly_1/2 no communication. . Check the CAN wiring. Make sure the
120 Q “end of line” resistors are present.

. Check the CAN settings in the CAN
Interface window in the Parameters
menu. CAN setting in EGS = 1536, CAN
setting in FireFly = 600. (See malfunction

150.)
. Refer to FireFly manual 36106.
281/286 FireFly_1/2 malfunction. ° Refer to FireFly manual 36106.

Resetting the EGS

A reset of the EGS can be done in two ways depending on the setting:

Auto reset

The EGS resets itself when an alarm is no longer valid. For example, if the CH4
signal has decreased then an alarm is given. When the signal returns (e.g. after
repairing the analyzer) the EGS waits 1 minute then switches to the OK status,
and the engine can be restarted. The alarm, and the number of times it has
occurred, is shown In “View” - “Diagnosis Alarm Status” or “Engine Alarm
Status List”. The alarm can only be cleared by using the Monitor program.

Manual Reset

Once an alarm has occurred the EGS switches to the alarm state and stays in
that state, even if the alarm is removed. This is enabled in “Diagnosis” - “Status”
- “Reset Options”. Resetting the EGS can only be done using the Monitor
program, or externally by supplying a current of more than 10 mA to terminal 71.

A 24 Vdc logical signal can also be used by configuring analog input 1
(“Parameters” > “Sensor” - “Universal Input 1”) as an mA input. Use an
external 1k8 Q resistor in series on terminal 71 to make a 13 mA signal.
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Chapter 9.
PASTOR

Introduction

The software PASTOR (Prime-mover Angular-speed Stability MoniTOR) is a part
of the EGS-01 control module, and it is built-in as the “misfire detection system”.
It can be found under the “Protection” menu. The software PASTOR replaces the
previously-used analog PASTOR circuit board. PASTOR measures the
irregularity of the engine speed, caused by every individual combustion cycle.
When this irregularity level exceeds an error limit, the alarm “engine unstable” is
given. If activated, the EGS-01 control can shutdown the engine.

A highly irregular signal can be caused by ignition problems (spark plugs, coils,
extenders, HT-leads, wiring, etc.) or by mechanical failure of the engine. Also an
erratic A/F-ratio (too lean) can cause a misfire and a PASTOR alarm.

The PASTOR alarm prevents the engine running in an overload or over-fuelled
condition, caused by one or more failed cylinders. On applications with a two-way
or three-way catalyst the PASTOR system also protects the catalyst from over-
heating caused by unburnt mixture which will be burnt in the catalyst.

When using the “Gas Quality Closed Loop” algorithm, the PASTOR
IMPORTANT system must be activated to prevent the engine running too rich if a
cylinder failure occurs. Specifically at landfill applications where the

amount of closed loop cannot be limited too much, the PASTOR is
very important.

Knocking combustion (detonation) will not be detected by the PASTOR system.
However knock detection is possible with the FireFly system, which can be
connected to the EGS-01 control.

Basic Irregularity |dn/dt|

Internal combustion engines which use the Otto or the Diesel cycle do not have
continuous combustion like turbines. The speed of the flywheel increases and
decreases all the time, even when the engine runs parallel to the grid, due to the
force of each individual combustion. This irregularity is calculated from the speed
signal and is called |dn/dt| and the units are in Hz/s.

When an engine runs with correct A/F-ratio and correct spark advance, and all
cylinders are firing normally, we call the irregularity “the basic irregularity”. The
level of this irregularity depends on the engine and its application (number of
cylinders, firing order, island or parallel operation, inertia of the engine plus
generator, and lean or stoichiometric mixture) and of the so called “sample
divider” (see next section).
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Sample Divider

Since the EGS control measures the speed every 5 ms (at 200 Hz) it can occur
that the EGS is measuring the |dn/dt| of the combustion itself, depending on the
number of cylinders and the firing order. To overcome this phenomena, it is
necessary to slow down the sample rate using the sample divider. In practice the
optimal value for a specific engine type has to be found, and this value is usually
between 1 and 4.

|dn/dt| Filter

To avoid erratic alarms caused by, for example, block loads or noise, the |dn/dt|
signal is (low pass) filtered. A practical filter value is 10 seconds.

Software PASTOR Commissioning

It is important that the engine is operating fully satisfactorily and with the correct
NOx during the adjustments to PASTOR.

If you already know the optimal sample divider for this engine, go to Setting the
Limits Versus Load below.

During commissioning disable the “shutdown” function on the
“ IMPORTANT PASTOR alarm.

HIGH VOLTAGE—Modern ignition systems can produce very high

Finding the Optimal Sample Divider
voltages, even on the primary side, which can be dangerous. Take

“ _ extra care when working on or near an ignition system.

A mounted oxidation catalyst can easily be destroyed by forcing the

engine to misfire. The unburnt fuel mixture will react with the

catalytic converter, thus causing the temperature to rise
dramatically.

1. Install switch in the primary side of one coil to simulate misfire and make sure
that the software PASTOR alarm is inactive during commissioning.

2. Adjust the |dn/dt] filter to 10 seconds.

3. Run the engine at full load and measure the |dn/dt| when the engine runs on
all cylinders. Compare this with the |dn/dt| when one cylinder is not firing. Do
this with different sample divider values.

4. Select the sample divider which gives the biggest difference between normal
running and running with one cylinder missing, usually a value between 1
and 4.

Setting the Limits Versus Load

In the “Pastor” window (under the Protection Menu) the alarm limits for the |dn/dt|
versus load can be set. There is a separate table for “island operation” and a
table for running parallel “on the grid”.
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Set the software PASTOR:

1. Run a few different load-steps, e.g. the load values of the software PASTOR
table, with the optimal sample divider value (see previous section) and a
|dn/dt| filter value of 10 s.

2. Make notes of the |dn/dt| at normal running and the |dn/dt| with one cylinder
“failed”.

3. Choose alarm limits for every load somewhere in between the two values.

Probably some field experience is needed to select the correct limit values.

Example
At 100% Load:

N°’T"a' running 1 cylinder misfire
engine

Divider dn/dt dn/dt

2 3.4-3.8 5.7-6.3

3 2.6-2.7 5.7-5.9

4 1.9-2.1 54-5.7

5* 1.8-1.9* 5.2-5.6*

6 1.7-1.6 5.04.9

7 1.6-1.7 4.6-4.7

8 1.5-2.0 4.1-5.8

* Sample 5 gives the biggest difference between normal running engine and engine with 1
cylinder misfiring.

Set sample divider at the ideal value found at 100% load (5 in this example).
Measure the difference:

N°’T"a' running 1 cylinder misfire
engine

Load Divider dn/dt dn/dt

80% 5 1.6-1.5 4.4-4.6

60% * 5 1.4-1.3 3.4-3.5

50% * 5 1.1-1.2 2.5-2.4

* Set trip values between normal running value and misfire value.

Filter time constant

Sample divider

Alarm level:
breaker open
(Hz/s)

ldn/dt]|

10 S
5

Island Alarm level: On the grid

breaker closed
|dn/dt|

(Hz/s)

Figure 9-1. PASTOR Window
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The software PASTOR will give an alarm, or an alarm plus “shut down”, when the
|dn/dt| signal is present for longer than a programmable time over the
programmed limit.

Enter a useful time limit, such as between 10 to 15 seconds.

Now activate the “shut down function” in the PASTOR window, and run the
engine on partial load. When you “fail” one cylinder, the engine will be stopped by
the EGS control after the error time has elapsed.

Alarms will be stored and can be viewed in the “View / Engine Alarm Status”
window.

The software PASTOR is now correctly set-up.

If in operation an “Engine Unstable” alarm occurs, please look very carefully at
the engine and the A/F-ratio.

It should not be necessary to re-adjust the |dn/dt| alarm limit in case
IMPORTANT of an alarm. Try to find the reason for the high |dn/dt|.
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Chapter 10.

FireFIzT"’I

Introduction

This chapter describes the combination of the FireFly with the EGS-01 control.
More information about the FireFly can be found in Woodward manual 36106.

Knocking combustion (or detonation) is a type of combustion which results in
very-high peak pressure in the combustion chamber, and which will damage the
engine very quickly. Detonation should normally always be avoided, and the
EGS-01 control helps prevent it.

For example, detonation can be caused:

e  Low methane number of the fuel

Engine runs too rich

Engine is overloaded or overheated

Incorrect ignition timing

Deposits in the combustion chamber, like ash from the lubricant or fuel

The EGS-01 control can protect an engine from detonation using a knock
detection system—the FireFly. This system is not a standard part of the EGS
delivery like the PASTOR and must be ordered separately.

Detonation Detection Module (FireFly)

The FireFly is a detonation detecting and controlling device which can detect
knock on between 4 to 16 cylinders. It uses up to 8 piezo-electric knock sensors.
If your engine needs more then 8 knock sensors a second FireFly can be used.

The FireFly forms an ideal combination with the EGS-01 control, but can also
work as a stand-alone system, as described in the FireFly manual. The knock
controlling strategy is located in the FireFly, and not in the EGS control. The
FireFly is connected to the EGS-01 control by the (TecJet) CAN bus.
Additionally, "Protocol 98" should be enabled under Parameters / CAN Interface
to enable communication between the FireFly and the EGS-01 control.

The FireFly requires the following signals:

e  Engine speed (rpm)

¢  Engine phase (camshaft sensor)

e  Knock sensor signals

e  Measured engine power (through the CAN bus)

The speed signal can be shared with the MPU of the EGS, although the use of a
separate MPU is recommended.

The FireFly can control detonation by retarding the ignition timing through its
analog output or RS-422/Modbus® * communication link. Depending on the
selected strategy, the FireFly can also reduce the engine load by a request to a
“higher system”, such as the plant control, through the RS-422/Modbus.
Alternatively, the FireFly can reduce the load by a request to the EGS-01 through
the CAN bus.

*—Modbus is a trademark of Modicon, Inc.
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Alternatively the FireFly can indicate the “engine knock severity” by an analog
output or through the RS-422/Modbus communication link, to allow another
system to control ignition timing and/or load.

Additionally, a relay output is available for shutdown and fault indication.

CAN Communication with the EGS-01 Control

The FireFly is the only extra system that can be connected to the (TecJet) CAN
communication bus. All other communication between EGS-01 and, for example,
the plant control is only possible through the EGS-01 RS-232/Modbus “plant
communication” connection.

As mentioned before, the knock strategy which controls the detonation detection
is located in the FireFly, which means that the FireFly can change system
parameters like the ignition timing. Since the total efficiency (and the NOx
emission) decreases when ignition timing is retarded, the EGS-01 needs to
“know” when the ignition is retarded. In GQCL, no information about the ignition
timing will make the engine richer until the NOx-emission is almost back to the
level before retarding. For this reason the total efficiency table/map in the EGS-
01 is a 3-D table, versus load% and actual ignition timing. Changing the total
efficiency at the retarded timing makes the emission low again.

When using variable ignition timing, the EGS-01 needs to “know” the actual
timing and the 3-D total efficiency table should be filled out completely. This can
be done by retarding the ignition “manually” using the FireFly monitor software.

The EGS-01 receives the following information from the FireFly (simplified)
through the CAN bus:

e  Degrees of ignition retarding.

¢  Amount of desired load reduction.

e  FireFly status (including “shut down” command).

e (Engine knock severity).

The EGS-01 sends the measured engine power to the FireFly (simplified).

Knock Strategy of the FireFly

There are four selectable strategies to use when controlling the detonation of a
stationary engine. Please refer to the FireFly manual 36106 for more detailed
information about these strategies.
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Chapter 11.

Service Options
|

Product Service Options

If you are experiencing problems with the installation, or unsatisfactory

performance of a Woodward product, the following options are available:

e Consult the troubleshooting guide in the manual.

e Contact the manufacturer or packager of your system.

e Contact the Woodward Full Service Distributor serving your area.

o Contact Woodward technical assistance (see “How to Contact Woodward”
later in this chapter) and discuss your problem. In many cases, your problem
can be resolved over the phone. If not, you can select which course of action
to pursue based on the available services listed in this chapter.

OEM and Packager Support: Many Woodward controls and control devices are
installed into the equipment system and programmed by an Original Equipment
Manufacturer (OEM) or Equipment Packager at their factory. In some cases, the
programming is password-protected by the OEM or packager, and they are the best
source for product service and support. Warranty service for Woodward products
shipped with an equipment system should also be handled through the OEM or
Packager. Please review your equipment system documentation for details.

Woodward Business Partner Support: Woodward works with and supports a
global network of independent business partners whose mission is to serve the
users of Woodward controls, as described here:

e A Full Service Distributor has the primary responsibility for sales, service,
system integration solutions, technical desk support, and aftermarket
marketing of standard Woodward products within a specific geographic area
and market segment.

e An Authorized Independent Service Facility (AISF) provides authorized
service that includes repairs, repair parts, and warranty service on Woodward's
behalf. Service (not new unit sales) is an AISF's primary mission.

¢ A Recognized Engine Retrofitter (RER) is an independent company that
does retrofits and upgrades on reciprocating gas engines and dual-fuel
conversions, and can provide the full line of Woodward systems and
components for the retrofits and overhauls, emission compliance upgrades,
long term service contracts, emergency repairs, etc.

o A Recognized Turbine Retrofitter (RTR) is an independent company that
does both steam and gas turbine control retrofits and upgrades globally, and
can provide the full line of Woodward systems and components for the
retrofits and overhauls, long term service contracts, emergency repairs, etc.

A current list of Woodward Business Partners is available at
www.woodward.com/support.
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Woodward Factory Servicing Options

The following factory options for servicing Woodward products are available
through your local Full-Service Distributor or the OEM or Packager of the
equipment system, based on the standard Woodward Product and Service
Warranty (5-01-1205) that is in effect at the time the product is originally shipped
from Woodward or a service is performed:

e Replacement/Exchange (24-hour service)

o Flat Rate Repair

o Flat Rate Remanufacture

Replacement/Exchange: Replacement/Exchange is a premium program
designed for the user who is in need of immediate service. It allows you to
request and receive a like-new replacement unit in minimum time (usually within
24 hours of the request), providing a suitable unit is available at the time of the
request, thereby minimizing costly downtime. This is a flat-rate program and
includes the full standard Woodward product warranty (Woodward Product and
Service Warranty 5-01-1205).

This option allows you to call your Full-Service Distributor in the event of an
unexpected outage, or in advance of a scheduled outage, to request a
replacement control unit. If the unit is available at the time of the call, it can
usually be shipped out within 24 hours. You replace your field control unit with
the like-new replacement and return the field unit to the Full-Service Distributor.

Charges for the Replacement/Exchange service are based on a flat rate plus
shipping expenses. You are invoiced the flat rate replacement/exchange charge
plus a core charge at the time the replacement unit is shipped. If the core (field
unit) is returned within 60 days, a credit for the core charge will be issued.

Flat Rate Repair: Flat Rate Repair is available for the majority of standard
products in the field. This program offers you repair service for your products with
the advantage of knowing in advance what the cost will be. All repair work carries
the standard Woodward service warranty (Woodward Product and Service
Warranty 5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture: Flat Rate Remanufacture is very similar to the Flat
Rate Repair option with the exception that the unit will be returned to you in “like-
new” condition and carry with it the full standard Woodward product warranty
(Woodward Product and Service Warranty 5-01-1205). This option is applicable
to mechanical products only.
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Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned for repair,
please contact your Full-Service Distributor in advance to obtain Return
Authorization and shipping instructions.

When shipping the item(s), attach a tag with the following information:
return number;

name and location where the control is installed;

name and phone number of contact person;

complete Woodward part number(s) and serial number(s);
description of the problem;

instructions describing the desired type of repair.

Packing a Control

Use the following materials when returning a complete control:

. protective caps on any connectors;

e antistatic protective bags on all electronic modules;

e  packing materials that will not damage the surface of the unit;

e atleast 100 mm (4 inches) of tightly packed, industry-approved packing
material;

a packing carton with double walls;

e a strong tape around the outside of the carton for increased strength.

To prevent damage to electronic components caused by improper

NO TICE handling, read and observe the precautions in Woodward manual
82715, Guide for Handling and Protection of Electronic Controls,
Printed Circuit Boards, and Modules.

Replacement Parts

When ordering replacement parts for controls, include the following information:
e the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
e the unit serial number, which is also on the nameplate.
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Electrical Power Systems

Engineering Services

Woodward offers various Engineering Services for our products. For these services,
you can contact us by telephone, by email, or through the Woodward website.

e Technical Support

e Product Training

o Field Service

Technical Support is available from your equipment system supplier, your local Full-
Service Distributor, or from many of Woodward’s worldwide locations, depending
upon the product and application. This service can assist you with technical
questions or problem solving during the normal business hours of the Woodward
location you contact. Emergency assistance is also available during non-business
hours by phoning Woodward and stating the urgency of your problem.

Product Training is available as standard classes at many of our worldwide
locations. We also offer customized classes, which can be tailored to your needs
and can be held at one of our locations or at your site. This training, conducted
by experienced personnel, will assure that you will be able to maintain system
reliability and availability.

Field Service engineering on-site support is available, depending on the product
and location, from many of our worldwide locations or from one of our Full-
Service Distributors. The field engineers are experienced both on Woodward
products as well as on much of the non-Woodward equipment with which our
products interface.

For information on these services, please contact us via telephone, email us, or
use our website and reference www.woodward.com/support, and then
Customer Support.

How to Contact Woodward
For assistance, call one of the following Woodward facilities to obtain the address
and phone number of the facility nearest your location where you will be able to
get information and service.

Engine Systems

Turbine Systems

--------------- Phone Number Facility --------------- Phone Number Facility --------------- Phone Number
Australia----------- +61 (2) 9758 2322  Australia----------- +61 (2) 9758 2322  Australia----------- +61 (2) 9758 2322
[ +55 (19) 3708 4800  Brazil ------------- +55 (19) 3708 4800  Brazil ------------- +55 (19) 3708 4800
------------ +86 (512) 6762 6727 China------------+86 (512) 6762 6727 China------------+86 (512) 6762 6727
Germany: Germany:
Kempen --- +49 (0) 21 52 14 51
Stuttgart ----- +49 (711) 78954-0 Stuttgart ----- +49 (711) 78954-0
India --------------- +91 (129) 4097100 India --------------- +91 (129) 4097100 India --------------- +91 (129) 4097100
Japan -------------- +81 (43) 213-2191  Japan -------------- +81 (43) 213-2191  Japan -------------- +81 (43) 213-2191
Korea--------------- +82 (51) 636-7080 Korea--------------- +82 (51) 636-7080 Korea--------------- +82 (51) 636-7080

Poland -------------- +48 12 618 92 00
United States-----+1 (970) 482-5811

The Netherlands -+31 (23) 5661111

United States-----+1 (970) 482-5811

The Netherlands -+31 (23) 5661111

United States-----+1 (970) 482-5811

You can also contact the Woodward Customer Service Department or consult our
worldwide directory on Woodward’s website (www.woodward.com/support)
for the name of your nearest Woodward distributor or service facility.

For the most current product support and contact information, please refer to the
latest version of publication 51337 at www.woodward.com/publications.

Woodward
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Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information.

Please write it down here before phoning:

General
Your Name

Site Location

Phone Number

Fax Number

Prime Mover Information
Engine/Turbine Model Number

Manufacturer

Number of Cylinders (if applicable)

Type of Fuel (gas, gaseous, steam, etc)

Rating

Application

Control/Governor Information

Please list all Woodward governors, actuators, and electronic controls in your system:

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

If you have an electronic or programmable control, please have the adjustment setting positions or

the menu settings written down and with you at the time of the call.
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Appendix A.
EGS-01 Technical Specifications

Weight

Power Supply Rating
Ambient Temperature Range
Humidity/Moisture

EMI/RFI

Analog Inputs
Lambda_1 thru Lambda_3
Map_1 thru Map_2
TPS
Detonation_1 thru Detonation_2
Power
CH4
Analog_1 thru Analog_2
For all analog inputs:

PT-100 inputs

Thermocouple Inputs

Phase Inputs

Speed Input

Digital Inputs

Relay
TecJet Power Supply

TecJet on/off
Heater Outputs

PWM Output

5 V Reference Output
RS-232 Cable

2.87 kg (6.33 Ib)

10-32 Vdc nominal (7 V minimum)

0to 55 °C

85 % , IP20

Heavy Industrial, EN50081-2/EN50082-2
ISO 7637-2 (24 V system)

0-25V/0-5V

0-5V/0-10V/0-20 mA
0-5V/0-10V/0-20 mA
0-5V/0-10V/0-20 mA
0-5V/0-10V/0-20 mA
0-5V/0-10V/0-20 mA
0-5V/0-10V/0-20 mA

Accuracy 1 % of full scale / Linearity 0.1 % Resolution
12 bit / Stability 1 % per year Common mode voltage.
Every input has an input range of =7 V up to + 14 V
for the high and the low input.

Resolution 11 bit over 120 °C

Accuracy 0.5 % of 100 ° C

Range —40 to +40 mV

Resolution 12 bit

Accuracy

Maximum frequency 100 Hz

Block signal:

Turn-over 0 V / Hysteresis 0.2 V

Min. amplitude 6 V / Max. amplitude 32 V
Common mode 10 V on the lo input.

AC signal:

Turn-over 0V

Min. amplitude 6 V / Max. amplitude 60 V
Common mode 10 V on the lo input.

Bobbin signal:

Turnover 100-150 V / Max. voltage 400 V
Accuracy 0.01 %

Maximum frequency 9 kHz

Block signal:

Turn-over 2.5 V / Hysteresis 0.2 V

Min. amplitude 5 V / Max. amplitude 32 V
Common mode 10 V on the lo input

AC signal:

Min. amplitude 6 V / Max. amplitude 60 V
Turnover 0 V

Common mode 10 V on the lo input
Logic0—>0-6V

Logic 1 —>4-32V

Current 1 A

Maximum current peak 10 A during 1 second.
Continuous 6 A

Maximum current 10 mA

Duty cycle 0—100 % / Frequency f =25 Hz
Accuracy 1 % / Resolution 8 bit

Peak current 20 A during 1 second (one single peak) /
Nominal current 5 A

Current 1.5 A/ Frequency 1000 Hz
Resolution 12 bit / Accuracy 0.1 % Push-pull
Accuracy 0.5 % / Current 70 mA

Plant communication port max. 9600 baud

Woodward
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Sensor Specifications

Woodward MAP Sensors The Woodward MAP sensors have better temperature
and EMC specifications than standard sensors.
USE OTHER SENSORS AT YOUR OWN RISK!
MAT Sensor PT100 sensor (3 m silicon cable) (1/4” NPT)
Installation Suitable for installation on the engine.
Mounting in inlet manifold after throttle valve.
Sensor tip must be positioned sufficiently far into the
inlet manifold, to ensure that the correct mixture
temperature is measured.
Electrical connections Fixed mounted 3 core silicon cable 3 m.
Core with the brown color is the PT100 signal. The
cores gray and black form the reference loop.
Maximum cable length between sensor and EGS is
20 m.
Maximum temperature range -50 °C to +200 °C
Maximum ambient
temperature, cable 150 °C

112 Woodward



Manual 36139 EGS-01 Digital Engine Gas Metering System

Appendix B.
Software Upgrade

Introduction

This chapter contains the software upgrade instructions for the EGS control
software and the speed control software.

The speed control software upgrade is only applicable for an EGS
“ IMPORTANT with speed and load control. H

EGS Software Upgrade

Perform the following steps to upgrade the EGS software:

—_—

Stop the engine.

2. Make sure the EGS is connected to the power supply and the “fuel on” signal
is present.

Go on-line with the same EGS monitor version as software version in the
EGS.

Save the EGS settings file on the PC.

Go off-line and close the EGS monitor.

Start the new EGS monitor version, don’t go on-line.

Go to the SYSTEM menu and choose “Install EGS Software”. The
information window as shown below will appear. Press OK.

w

No oA

This will install new software in the EGS controller. Before
proceeding, please take note of the following instructions:

*
Make sure you backed up the EGS parameters!
After installation, the EGS will disable the motor until
you go online by transmitting these parameters.
*

Any logging information will be lost during installation.
*

Stop the engine during the installation.
*

Press OK to select the source directory.

8. In the directory tree, choose the directory containing the new version
EGSAPP.EXE and press the “Chdir” button. In the “Directory name” box you
will now see the directory you have chosen.

Directory ame
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9. Press “OK” button to start the software download process. After a few seconds
the Confirm window appears for a last confirmation. Press the “OK” button.

The system will now install

the new software to the EGS.
If you wish to cancel the

operatioh, press Cancel now,
or press OE to proceed.

l Cancel I

10. After software download has been completed successfully, the Information
window will appear. Press the “OK” button.

Software installation successful.

11. Open the old settings file using the new version monitor program.

12. Check all the settings in the Parameters, Protection and Diagnosis windows.
Some settings may have been changed due to changes in the new software.

13. Go on-line by sending the settings file from the PC to the EGS.

Speed Control Software Upgrade

This upgrade is only applicable for an EGS with speed and load control. Perform
the following steps to upgrade the EGS software (refer to Figures B-1 and B-2):

Stop the engine.

Remove the power supply and the “fuel on” signal from the EGS.

Remove the four small screws and the cover from the EGS.

Locate the speed control board in the top right corner of the EGS (with the

EGS connectors pointing towards you). On the board look for the type

number 5550A or 5550B. If the board is type number 5550A the software can

only be upgraded to software version 1.09 (please contact Woodward if a

later upgrade is necessary).

5. Locate board PC104 below the speed control board. Disconnect the small
ribbon cable, which connects between the EGS board and board PC104,
from board PC104. Connect the cable to the speed control board (this
connects the speed control board to the communication port).

6. Connect the PC to the EGS plant communication port.

7. Start the PC in MS-DOS mode. Go to the directory that contains the new
software.

8. Connect the EGS to the power supply and make sure the “fuel on” signal is
present. Ignore the red alarm LED.

9. Run the “send.bat” file. Change the COM port if necessary.

10. When the software is uploaded remove the power supply and the “fuel on”
signal from the EGS. Disconnect the PC from the EGS plant communication
port.

11. Disconnect the small flat cable from the speed control board and connect it to

board PC104.

PN~
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12. Install the cover and the screws on the EGS.

13. Make sure all system connectors are correctly connected to the EGS. Supply
power to the EGS.

14. Check the EGS for correct calibration and operation.

Speed Control
Board

Board PC104

Ribbon Cable

EGS Board

Figure B-1. Location of EGS, PC104 and Speed Control Boards

EGS Plant
Communication Port

Figure B-2. Location of EGS Plant Communication Port
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Appendix C.

List of Abbreviations

A/F ratio
Ccorr

CH4
dMAP/dt
DOS

dT

EGS
EMC
EMI
FGP
FGT
GQCL
hPa

HT

Inlet Temp
I

kPa

M

MAP
MAT
MPU
PASTOR
PC

PCB
Pcal

Pmech

PID
PWM
Qgn

Qmn

Ref
RFI
TDC
T-type
UEGO
\Y

Ve

Air/Fuel ratio

See Mono Engine & Lambda Control section in Chapter
3

Methane

Delta Manifold Air Pressure / time

Disk Operating System

Delta Temperature

Engine Gas-metering System

Electromagnetic Compatibility

Electromagnetic Interference

Fuel Gas Pressure

Fuel Gas Temperature

Gas Quality Closed Loop

hectopascal

High Tension

Inlet Temperature

Air/Fuel ratio

kilopascal

See Mono Engine & Lambda Control section in Chapter
3

Manifold Air Pressure

Manifold Air Temperature

Magnetic Pickup

Prime-mover Angular-speed Stability moniTOR
Personal Computer

Printed Circuit Board

See Mono Engine & Lambda Control section in Chapter
3

See Mono Engine & Lambda Control section in Chapter
3

Proportional Integral Derivative

Pulse Width Modulation

See Mono Engine & Lambda Control section in Chapter
3

See Mono Engine & Lambda Control section in Chapter
3

Reference

Radio Frequency Interference

Top Dead Center

Thermocouple type

Universal Exhaust Gas Oxygen

See Mono Engine & Lambda Control section in Chapter
3

Volumetric Efficiency
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We appreciate your comments about the content of our publications.
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